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1. Trademarks

—O 1. TRADEMARKS

The terms HDMI, HDMI®High-Definition Multimedia Interface and the HDMI®logo are trademarks or
registered trademarks of HDMI®Licensing LLC in the United States and other countries.

HDBaseT™ and the HDBaseT Alliance logo are trademarks of the HDBaseT Alliance.

—O 2. INTRODUCTION

Thank you for choosing the Analog Way SmartMatriX2. Before you start setting up your SmartMatriX? for the
first time, please read through all of the documentation to become familiar with its powerful features. The
SmartMatriX? can be used in several configurations, which results in a versatile video production tool for live
event staging and fixed installation applications.




3. Terms and definitions

3. TERMS AND DEFINITIONS

BACKGROUND: a “Background” is a source, typically originating from a computer. SmartMatriX? enables you
to work with still (frame) background — visually in back of all other sources.

LAYER: a “layer” is an image display element (such as a PIP window, Key, logo or Background) that has a visual
priority — either in front (or in back) of another layer. 1 frame non-resizable, up to 2 live layers resizable and
1 logo available on the SmartMatriX2.

PIP: a “PIP” (Picture In Picture) is a picture, typically of reduced size, which is positioned over another
background image or other PIPs. PIPs can be repositioned, reduced, enlarged and displayed with borders.
PIPs can overlap, depending on their visual priority. SmartMatriX? offers various slides, wipes, and fades
for dynamic PIP entrances and exits. A “flying” PIP is also possible using vertical, horizontal, or diagonal
movement. A PIP is considered as a layer.

FRAME: a “frame” is a full screen image which is selected from one of the still frames you can capture. A
frame can be captured in flash memory from any video or computer source plugged into the machine.

LOGO: a “logo” is a part of a screen image that can be captured in flash memory from any video or computer
source, by keying or image cut-out. A logo can be positioned anywhere on the screen.

KEYING: “Key” is an electronic process whereby a video image is electronically superimposed over another
source or background, by dynamically removing a portion of the first image. For example, removing all
content of a certain color (such as green or blue) is called a Chroma Key, and removing content based on
its brightness or luminance levels is called a (Luma Key). Keys are typically used for titles, logos and special
effects. SmartMatriX? allows you to key a live source (such as a camera shot with green or blue background,
or a title with a black background) over any other source or sources.

SEAMLESS: Clean transition with no glitch or loss of sync while switching between two sources. For example,
fading through black to another source is a seamless transition.

TRUE SEAMLESS: Clean seamless transitions with no glitch or freeze between two sources. For example,
crossfading from source to source is a true seamless transition.

RCS%: Remote Control Software used to control, set up, and operate the device.

QUICK FRAME: The “Quick Frame” feature allows the instant display of a stored frame above all layers.




4.1.1 English

—O 4. HARDWARE SPECIFICATIONS

4.1 Safety instructions
4.1.1 English

For optimal use of this device, read all safety and operating instructions before use. Keep the safety and
operating instructions for future reference. Please follow all of the warnings on this product and its operating
instructions.

* WARNING: To prevent the risk of electric shock and fire, do not expose this device to rain, humidity or
intense heat sources (such as heaters and direct sunlight). Slots and openings in the device are provided for
ventilation and to avoid overheating. Make sure the device is never placed near a textile surface that could
block the openings. Also keep away from excessive dust, vibrations and shocks.

® POWER: Only use the power supply indicated on the device of the power source. Devices equipped with
a grounding plug should only be used with a grounding type outlet. In no way should this grounding be
modified, avoided or suppressed. Connection of equipment to main supply must be after branch circuit
breaker of the building installation.

e POWER CORD: The device is equipped with a detachable power cord. To remove mains, switch off the
device and disconnect the power cord at appliance coupler.

Caution: The power cord constitutes the only mean to completely disconnect the equipment from the main
power.

Apply the following guidelines:
- The equipment connected to the network must have a release system easily accessible and located
outside the unit.
- Unplug the power cord; do not pull on the power cord but always on the plug itself.
- The outlet should always be near the device and easily accessible.
- Power supply cords should be routed so that they are not likely to be walked on or pinched by items
placed upon or against them.

If the power supply cord is damaged, unplug the device. Using the device with a damaged power supply cord
may expose your device to electric shocks or other hazards. Verify the condition of the power supply cords
once in a while. Contact your dealer or service center for replacement if damaged.

e CONNECTIONS: All inputs and outputs (except for the power input) are Safety Extra Low Voltage (SELV)
circuits as defined in UL/IEC 60950-1.

e SERVICING: Do not attempt to service this product yourself by opening or removing covers and screws
since it may expose your device to electric shocks or other hazards. Refer all problems to qualified service
personnel. You may lose warranty when you open the unit.

e OPENINGS: Never push objects of any kind into this product through the openings. If liquids have been

spilled or objects have fallen into the device, unplug it immediately and have it checked by a qualified
technician.
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4.1.2 French

4.1.2 French

Pour une utilisation optimale de cet appareil, nous vous conseillons de bien lire toutes les consignes de sécurité
et de fonctionnement avant utilisation. Conservez les instructions de sécurité et de fonctionnement afin de
pouvoir les consulter ultérieurement. Respectez toutes les consignes marquées dans la documentation, sur le
produit et sur ce document.

e ATTENTION : Afin de prévenir tout risque de choc électrique et d’incendie, ne pas exposer cet appareil a la
pluie, a I'humidité ou a des sources de chaleur intense.

o [INSTALLATION : Veillez a assurer une circulation d’air suffisante pour éviter toute surchauffe a I'intérieur de
I'appareil. Ne placez pas I'appareil sur ou a proximité d’une surface textile susceptible d’obstruer les orifices de
ventilation. N’installez pas I'appareil a proximité de sources de chaleur comme un radiateur ou une poche d’air
chaud, ni dans un endroit exposé au rayonnement solaire direct, a des poussiéres excessives, a des vibrations
ou a des chocs mécaniques. Ceci pourrait provoquer un mauvais fonctionnement et un accident.

e ALIMENTATION : Ne faire fonctionner I'appareil qu’avec la source d’alimentation indiquée sur l'appareil.
Les appareils doivent étre obligatoirement connectés sur une source équipée d’une mise a la terre efficace.
En aucun cas cette liaison de terre ne devra étre modifiée, contournée ou supprimée. Raccordement des
équipements a I'alimentation principale doit étre postérieur au disjoncteur de branchement de I'installation
électrique du batiment.

e CORDON D’ALIMENTATION : Les appareils sont équipés d’un cordon d’alimentation détachable. La mise
hors tension se fait sur appareil éteint en débranchant ce cordon de I'appareil.

Attention : le cordon d’alimentation constitue le seul moyen de débrancher l'appareil totalement de
I'alimentation secteur. Pour étre certain que I'appareil n’est plus alimenté, ce cordon doit étre
débranché de la prise murale.

Appliquer les consignes suivantes :

- Le matériel relié a demeure au réseau, doit avoir un dispositif de sectionnement facilement accessible
qui doit étre incorporé a I'extérieur de l'appareil.

- Débrancher le cordon d’alimentation de la prise murale si vous prévoyez de ne pas utiliser 'appareil
pendant quelques jours ou plus.

- Pour débrancher le cordon, tirez-le par la fiche. Ne tirez jamais sur le cordon proprement dit.

- La prise d’alimentation doit se trouver a proximité de l'appareil et étre aisément accessible.

- Ne laissez pas tomber le cordon d’alimentation et ne posez pas d’objets lourds dessus.

Si le cordon d’alimentation est endommagé, débranchez-le immédiatement de la prise murale. Il est
dangereux de faire fonctionner un appareil avec un cordon endommagé ; un cable abimé peut provoquer un
risque d’incendie ou un choc électrique. Vérifiez le cable d’alimentation de temps en temps. Contactez votre
revendeur ou le service aprés-vente pour un remplacement.

e CONNEXIONS : Toutes les entrées et sorties (exceptée I'entrée d’alimentation) sont des circuits de tres
basse tension de sécurité (TBTS) tels que définis dans UL / IEC 60950-1.

e REPARATION ET MAINTENANCE : Lutilisateur ne doit en aucun cas essayer de procéder aux opérations de
dépannage, car l'ouverture des appareils par retrait des capots ou de toutes autres pieces constituant les
boitiers ainsi que le dévissage des vis apparentes a I'extérieur, risquent d’exposer l'utilisateur a des chocs
électriques ou autres dangers. Contactez le service aprés-vente, votre revendeur ou adressez-vous a un
personnel qualifié uniguement. Uouverture de I'appareil provoque la perte de la garantie.

e OUVERTURES ET ORIFICES : Les appareils peuvent comporter des ouvertures (aération, fentes, etc...),
veuillez ne jamais y introduire d’objets et ne jamais obstruer ses ouvertures. Si un liquide ou un objet
pénétre a l'intérieur de l'appareil, débranchez immédiatement I'appareil et faites-le controler par un
personnel qualifié avant de le remettre en service.
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4.1.3 Italian

4.1.3 Italian

Per un utilizzo ottimale dell'apparecchio, leggere tutte le istruzioni di sicurezza e di utilizzo prima dell’uso.
Conservare le istruzioni di sicurezza e di funzionamento al fine di poterle consultare ulteriormente. Seguire
tutti i consigli indicati su questo manuale e sull’apparecchiatura.

e ATTENZIONE:Alfinediprevenire qualsiasirischiodishockelettricoed’incendio, nonesporrel’apparecchiatura
a pioggia, umidita e a sorgenti di eccessivo calore.

o INSTALLAZIONE: Assicuratevi che vi sia una sufficiente circolazione d’aria per evitare qualsiasi
surriscaldamento all’interno dell'apparecchiatura. Non collocare I'apparecchiatura in prossimita o su
superfici tessili suscettibili di ostruire il funzionamento della ventilazione. Non installate I'apparecchiatura
in prossimita di sorgenti di calore come un radiatore o una fuoruscita d’aria calda, né in un posto esposto
direttamente ai raggi del sole, a polvere eccessiva, a vibrazioni o a shock meccanici. Cié potrebbe provocare
un erroneo funzionamento e un incidente.

e ALIMENTAZIONE: Far funzionare l'apparecchiatura solo con la sorgente d’alimentazione indicata
sull'apparecchiatura. Le apparecchiature queste devono essere obbligatoriamente collegate su una sorgente
fornita di una efficiente messa a terra. In nessun caso questo collegamento potra essere modificato, sostituito
o eliminato. Connessione delle apparecchiature alla rete elettrica deve essere successiva interruttore di
circuito dell’impianto dell’edificio

e CAVO DI ALIMENTAZIONE: Questo apparecchio e’ equipaggiato con un cavo di alimentazione . Per
rimuoverlo, spegnete l'apparecchio e disconnettere il cavo di alimentazione dalla presa di corrente.

Attenzione: il cavo di alimentazione ¢€ il solo modo di disconnettere I'apparecchio dell’alimentazione. Per
assicurarsi che totalemente I'apparecchio non & piu collegato, il cavo deve essere disconesso della presa
murale.

Seguire le instruzioni seguenti:

- Il materiale collegato a residenza alla rete, deve avere un dispositivo di sezionamento facile da
raggiongere eche deve essere inserito all’esterno del apparecchio.

- Disconnettere I'apparecchiatura dalla presa murale se si prevede di non utilizzarla per qualche giorno.

- Per disconnettere il cavo tirare facendo forza sul connettore.

- La presa d’alimentazione deve trovarsi in prossimita dell'apparecchiatura ed essere facilmente
accessibile.

- Non far cadere il cavo di alimentazione né appoggiarci sopra degli oggetti pesanti. Se il cavo di
alimentazione é danneggiato, spegnere immediatamente I'apparecchiatura.

E’ pericoloso far funzionare questa apparecchiatura con un cavo di alimentazione danneggiato, un cavo
graffiato pud provocare un rischio di incendio o uno shock elettrico. Verificare il cavo di alimentazione spesso.
Contattare il vostro rivenditore o il servizio assistenza per una sostituzione.

e CONNESSIONE: Tutti gli ingressi e le uscite (tranne che per la potenza in ingresso) sono bassissima tensione
di sicurezza (SELV) circuiti definiti UL / IEC 60950-1.

e RIPARAZIONI E ASSISTENZA: L'utilizzatore non deve in nessun caso cercare di riparare I'apparecchiatura,
poiché con l'apertura del coperchio metallico o di qualsiasi altro pezzo costituente la scatola metallica,
nonché svitare le viti che appaiono esteriormente, poiché cié pud provocare all’utilizzatore un rischio di
shock elettrico o altri rischi. Qualora si apra I'unita’, la garanzia non sara’ pil’ valida.

e APERTURE DI VENTILAZIONE: Le apparecchiature possono comportare delle aperture di ventilazione, si
prega di non introdurre mai oggetti o ostruire le sue fessure. Se un liquido o un oggetto penetra all’interno
dell’apparecchiatura, disconnetterla e farla controllare da personale qualificato prima di rimetterla in
servizio.
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4.1.4 German

4.1.4 German

Zum optimalen Gebrauch dieses Gerates lesen Sie bitte vorher alle Sicherheits- und Bedienhinweise.
Diese Sicherheits- und Betriebsanweisungen fiir einen spateren Gebrauch sicher aufbewahren. Alle in den
Unterlagen, an dem Gerat und hier angegebenen Sicherheitsanweisungen einhalten.

e ACHTUNG: um jegliches Risiko eines Stromschlags oder Feuers zu vermeiden, das Gerat nicht Regen,
Feuchtigkeit oder intensiven Warmequellen aussetzen.

¢ EINBAU: Eine ausreichende Luftzufuhr sicherstellen, um jegliche Uberhitzung im Gerit zu vermeiden. Das
Gerat nicht auf und in Nahe von Textiloberflachen, die BellUftungsoffnungen verschlieRen kénnen, aufstellen.
Das Gerdt nicht in Nahe von Warmequellen, wie z.B. Heizkdrper oder Warmluftkappe, aufstellen und es
nicht dem direkten Sonnenlicht, Gbermaligem Staub, Vibrationen oder mechanischen Stéf3en aussetzen.
Dies kann zu Betriebsstorungen und Unféllen fihren.

¢ STROMVERSORGUNG: Das Gerat nur mit der auf dem Gerat bezeichnete Stromquelle betreiben. Gerat mit
geerdeter Hauptstromversorgung muss an eine Stromquelle mit effizienter Erdung angeschlossen werden.
Diese Erdung darf auf keinen Fall gedandert, umgangen oder entfernt werden. Anschluss von Geraten ans
Stromnetz muss nach Abzweigschalter des Gebadudes Installation

e NETZKABEL: Das Gerat ist mit einem entfernbaren Netzkabel ausgestattet. Um das Gerat vollstandig vom
Netz zu trennen, schalten Sie es aus und ziehen Sie das Netzkabel ab.

Achtung: Das Netzkabel stellt die einzige Moglichkeit dar, das Gerat vollstandig vom Netzanschluss zu trennen.
Um sicherzustellen, dass das Gerat nicht mehr versorgt wird, muss dieses Kabel aus der Netzsteckdose
ausgesteckt werden.

Bitte beachten Sie die folgenden Hinweise:
- Wenn Gerate dauerhaft am Netz bleiben, missen sie Gber eine leicht zugangliche Trennvorrichtung
verfligen, die aullen am Gerat angebracht sein muss.
- Das Kabel mittels dem Stecker herausziehen. Niemals am Stromkabel selbst ziehen.
- Die Steckdose muf3 sich in der Nahe des Gerats befinden und leicht zuganglich sein.
- Das Stromkabel nicht fallen lassen und keine schweren Gegenstande auf es stellen.

Wenn das Stromkabel beschadigt ist, das Gerat sofort abschalten. Es ist gefdhrlich das Gerat mit einem
beschadigten Stromkabel zu betreiben; ein abgenutztes Kabel kann zu einem Feuer oder Stromschlag
flhren. Das Stromkabel regelmaRig untersuchen. Fir den Ersatz, wenden Sie sich an Ihren Verkaufer oder
Kundendienststelle.

e ANSCHLUSSE: Alle Eingdnge und Ausgidnge (mit Ausnahme der Stromversorgung) sind Safety Extra Low
Voltage (SELV) Schaltungen wie in UL / IEC 60950-1 definiert.

e REPARATUR UND WARTUNG: Der Benutzer darf keinesfalls versuchen das Gerat selbst zu reparieren, die
Offnung des Gerits durch Abnahme der Abdeckhaube oder jeglichen anderen Teils des Gehdusessowie die
Entfernung von aullen sichtbaren Schrauben zu Stromschlagen oder anderen Gefahren fiir den Benutzer
fihren kann. Wenden Sie sich an Ihren Verkaufer, lhre Kundendienststelle oder an qualifizierte Fachkrafte.
Das Offnen des Geh&uses fiihrt zum Verlust der Garantie.

e OFFNUNGEN UND MUNDUNGEN: Die Gerite kdnnen tiber Offnungen verfiigen (Beliiftung, Schlitze, usw.).
Niemals Gegenstinde in die Offnungen einfiihren oder die Offnungen verschlieBen. Wenn eine Fliissigkeit
oder ein Gegenstand in das Gerat gelangt, den Stecker herausziehen und es vor einer neuen Inbetriebnahme
von qualifiziertem Fachpersonal iberpriifen lassen.
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4.1.5 Spanish

4.1.5 Spanish

Para un uso éptimo de este equipo, lea las instrucciones de seguridad y operacion antes de utilizarlo. Conserve
las instrucciones de seguridad y de funcionamiento para que pueda consultarlas posteriormente. Respete
todas las consignas indicadas en la documentacion, relacionadas con el producto y este documento.

e CUIDADO: Para prevenir cualquier riesgo de choque eléctrico y de incendio, no exponga este aparato a la
lluvia, a la humedad ni a fuentes de calorintensas.

o INSTALACION: Cerciérese de que haya una circulacién de aire suficiente para evitar cualquier
sobrecalentamiento al interior del aparato. No coloque el aparato cerca ni sobre una superficie textil que
pudiera obstruir los orificios de ventilacidon. No instale el aparato cerca de fuentes de calor como radiador o
boca de aire caliente, ni en un lugar expuesto a los rayos solares directos o al polvo excesivo, a las vibraciones
o a los choques mecdnicos. Esto podria provocar su mal funcionamiento o un accidente.

e ALIMENTACION: Ponga a funcionar el aparato Gnicamente con la fuente de alimentacién que se indica en
el aparato. Los aparatos deben estar conectados obligatoriamente a una fuente equipada con una puesta
a tierra eficaz. Por ninglin motivo este enlace de tierra debera ser modificado, cambiado o suprimido.
Conexién del equipo a la red eléctrica debe ser posterior del interruptor de circuitos derivados de la
instalacidon del edificio

e CABLEDE CORRIENTE: El equipo se suministra con un cable de alimentacidon desmontable. Para desconectar
de la red eléctrica, apague primero el equipo y después, desconecte el cable de alimentacion de la red
eléctrica.

Atencion: El cable de alimentacién constituye el unico medio de desconectar el aparato totalmente de la
red eléctrica. Para estar seguro de que el aparato no esta mas alimentado, este cable debe de ser
desconectado de la toma de corriente.

Aplicar las siguientes consignas:
- El material conectado a residencia a la red informatica, debe de tener un dispositivo de seccionamiento
facilmente accesible que debe de ser incorporado al exterior del aparato.
- Desconectar el aparato del enchufe mural si no piensa utilizarlo durante varios dias.
- Para desconectar el cable, tire de la clavija. No tire nunca del cable propiamente dicho.
- El enchufe de alimentacién debe estar cerca del aparato y ser de facil acceso.
- No deje caer el cable de alimentacién ni coloque objetos pesados encima de él.

Si el cable de alimentacién sufriera algun dafio, ponga el aparato inmediatamente fuera de tensién. Es
peligroso hacer funcionar este aparato con un cable averiado, ya que un cable dafado puede provocar un
incendio o un choque eléctrico. Verifique el estado del cable de alimentacidn de vez en cuando. Péngase en
contacto con su distribuidor o con el servicio de posventa si necesita cambiarlo.

e CONEXIONES: Todas las entradas y salidas (a excepcidn de la entrada de alimentacion) son de tensidn extra
baja de seguridad (SELV) circuitos definidos en UL / IEC 60950-1.

e REPARACION Y MANTENIMIENTO: Por ninglin motivo, el usuario debera tratar de efectuar operaciones
de reparacion, ya que si abre los aparatos retirando el capd o cualquier otra pieza que forma parte de las
cajas o si destornilla los tornillos aparentes exteriores, existe el riesgo de producirse una explosién,choques
eléctricos o cualquier otro incidente. Contacte el servicio de posventa, a su distribuidor o dirigirse con
personal cualificado Unicamente. La unidad pierde la garantia si esta ha sido abierta.

e ABERTURAS Y ORIFICIOS: Los aparatos pueden contener aberturas (aireacion, ranuras, etc.). Nointroduzca
alli ninglin objeto ni obstruya nunca estas aberturas. Si un liquido o un objeto penetra al interior del aparato,
desconéctelo y hagalo revisar por personal cualificado antes de ponerlo nuevamente en servicio.
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4.2 Unpacking and inspection

4.2 Unpacking and inspection

¢ 1 x SmartMatriX? (SMX250 / SMX250-H)

e 1 x Power supply cord

e 1 x Ethernet cross cable (for device update)

¢ 1 x Remote Control Software (RCS?)*

e 1 x Set of 6 audio 5-pin screw terminals

¢ 1 x Front rack ears (the parts are stowed in the packaging foam)
¢ 1 x User manual (PDF)*

¢ 1 x Quick start guide*

* User manual, quick start guide and the RCS? are available on www.analogway.com

Before racking and plugging any inputs and outputs, it is advised to power on the unit. Should you encounter
any issue, you must contact immediately your local distributor or dealer, or closest Analog Way technical
support offices (see chapter: 12. Contact information).

4.3 Rack mount information

Tabletop mounting: The SmartMatriX? can be used directly on a table; the unit is equipped with 4 handy
anti-slip rubber feet.

Rack mounting: The SmartMatriX? is compatible with a 19” enclosure. Please follow the instructions below
to install the device in a 19” rack.

Place the device in your rack. Attach the device to the rack by screwing 2 front ears on it (screws not included).
Rear fixing is also recommended, in particular for permanent installations.
Connect all of the cables of the device and attach them to the rack with the help of tie wraps.

IMPORTANT:

- The openings in the side of the device are for cooling. Do not cover these openings to avoid blocking air
circulation.

- Be sure that no weight in excess of 2 kg (4.4 Lbs.) is added onto the SmartMatriX>2.

- The maximum ambient operating temperature should not exceed 40°C (104°F).

- The rack and all mounted equipment in it must be reliably grounded according to national and/or local
electrical standards.

Dismantling front handles of the device could invalidate warranty on after-sales services of your

A SmartMatriX?. It is strongly advised to avoid using front handles as rests for your SmartMatriX?,
they are designed for manipulation purposes only.

If required, front handles of the device can be dismantled, but with caution. The original screws removed

must not be reintroduced to their location without handles in place. Substantial damages can occur,

including risk of electric shock from the main voltage. Only M4x12mm screws can be used. They are

supplied with the unit.
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4.4 Cable and adaptator information

4.4 Cable and adaptor information

A large choice of cables and adaptors are compatible with the SmartMatriX2. Please refer to the hardware
specifications chapter to find the most suitable cables for your operations.

4.5 Hardware specifications
4.5.1 Signal descriptions

For each type of signal, here are the levels and the impedance accepted by the SmartMatriX2.

Analog SDTV Digital SDTV
Type Levels Impedance Type Characteristics
Composite 0,7 Vpp + 0,3 Vpp 750 SD-SDI YUV - 10 bits —4.2.2 - 270 Mb/s
S. Video Y =0,7 Vpp + 0,3 Vpp No payload ID management
C=0,7 Vpp 750 Only A-level type
YUV Y'=0,7 Vpp +0,3 Vpp DV RGB ou YUV — 8 bits — 4.4.4 — 16/235 - TMDS
U=0,7 Vpp 75Q HDMI RGB or YUV — 8 bits—4.4.4 or 4.2.2
V=0,7 Vpp —16/235 -TMDS
RGsB R=0,7 Vpp HDBaseT RGB or YUV —8 bits—4.4.40r 4.2.2
G=0,7Vpp +0,3 Vpp 75Q —16/235
B=0,7 Vpp
R, G,B=0,7 Vpp R,G,B=75Q
or
S=TTL
Analog EDTV Digital EDTV
Type Levels Impedance Type Characteristics
YUV Y=0,7Vpp + 0,3 Vpp DVI RGB or YUV — 8 bits —4.4.4 — 16/235 - TMDS
U=0,7Vpp 750Q HDMI RGB or YUV — 8 bits — 4.4.4 or 4.2.2
V=0,7Vpp -16/235-TMDS
RGsB R=0,7Vpp HDBaseT RGB or YUV — 8 bits — 4.4.4 or 4.2.2
G=0,7Vpp+0,3Vpp 75Q —-16/235
B=0,7 Vpp
R, G,B=0,7 Vpp R,G,B=75Q
or
S=TTL
Digital HDTV

Analog HDTV Type Characteristics

. Y . HD-SDI YUV - 10 bits — 4.2.2 — 1,485Gb/s and
These formats are compatible with bi-level and tri 1.485/1,001Gb/s

level sync on 1 or 3 wires. Only A-level type
Input and output payload ID management

Type Levels UREEHENTE for HDTV format only
YUV Y =0,7 Vpp 0,3 Vpp
\L;fg'; \\jpp :—'8'?3’ \\;pp 750 3G-SDI YUV - 10 bits — 4.2.2 - 2,97Gb/s and
=57 Vpp 25,5 VPP 2,97/1.001Gb/s
RGsB R=0,7 Vpp £0,3 Vpp Only A-level type
G=0,7 Vpp 0,3 Vpp 75Q Input and output payload ID management
B=0,7 Vpp £0,3 Vpp for HDTV format only
DVI RGB or YUV — 8 bits — 4.4.4 — 16/235 - TMDS
HDMI RGB or YUV — 8 bits—4.4.4 or 4.2.2
—16/235-TMDS
HDBaseT RGB or YUV —8 bits—4.4.40r 4.2.2
—-16/235
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4.5.2 Supported video formats

Analog computer Digital computer

Type Levels Impedance Type Characteristics
RGsB R=0,7 Vpp DVI RGB — 8 bits — 4.4.4 — 0/255 - TMDS
G=0,7Vpp+0,3Vpp 50 HDMI® RGB or YUV — 8 bits — 4.4.4 or 4.2.2

B=0,7Vpp —0/255 - TMDS
RGBS R,G,B=0,7Vpp RGB=750 HDBaseT RGB or YUV — 8 bits — 4.4.4 or 4.2.2

$=0,3Vpp75Qo0rS=TTL ~16/235
R, G,B=0,7 Vpp R,G,B=750Q
RGBHV
H=TTLand V=TTL

4.5.2 Supported video formats

The SmartMatriX? can support all the following video formats:

SDTV formats
Standard Size Vertical frequency Horizontal frequency
NTSC 525/480i 59.94Hz/60Hz 15,735 KHz
PAL 625/576i 50Hz 15.625 KHz
SECAM 625/576i 50Hz 15.625 KHz
EDTV formats
Standard Size Vertical frequency Horizontal frequency
480p 525/480p 59.94Hz/60Hz 31.47 KHz
576p 625/576p 50Hz 31.25 KHz
HDTV formats
Standard Size Vertical frequency
720p 1280 x 720 23.97Hz/24Hz/25Hz/29,97Hz/30Hz/50Hz/59.94Hz/60Hz
1035i 1920 x 1035 59.94Hz/60Hz
1080i 1920 x 1080 50Hz/59.94Hz/60Hz
1080sF 1920 x 1080 50Hz/59.94Hz/60Hz
1080p 1920 x 1080 23.97Hz/24Hz/25Hz/29,97Hz/30Hz/50Hz/59.94Hz2/60Hz
Cinema formats
Format Size Vertical frequency
DCDM 2048 x 1080 24Hz

4.5.3 Computer formats

Important: The maximum pixel clock frequency is 165 MHz. Supported formats include 1920x1200 @ 60hz
RB, 1600x1200 @60hz RB, 2048x1152 @60hz RB.

4.5.4 Input Computer formats

The SmartMatriX? inputs support GTF (version 1.1), CVT (version 1.1) and DMT (version 1.0 rev 12) standards.
All others non-standard formats are supported via the custom format capability of the framework.



4.5.5 Output computer formats

4.5.5 Output Computer formats

The SmartMatriX? outputs support GTF (version 1.1), CVT (version 1.1) and DMT (version 1.0 rev 12) stan-
dards. Other non-standard formats are supported via the custom format capability of the framework.

The SmartMatriX? offers a list of pre-defined output formats. The list of output formats is always displayed
from increasing number of pixels per line and then number of lines.

Format Size Aspect ratio 50 :rzequenscz Hz Format Size Aspect ratio 50 :rzequeng(y; Hz
VGA 640x480 4/3 Yes Yes WSXGAP 1680x1050 16/9 Yes Yes
WVGA 848x480 16/9 Yes Yes 1080p 1920x1080 16/9 Yes Yes
SVGA 800x600 4/3 Yes Yes 2K 2048x1080 17/9 Yes Yes
720p 1280x720 16/9 Yes Yes UXGA 1600x1200 4/3 Yes Yes
XGA 1024x768 4/3 Yes Yes WUXGA 1920x1200 16/9 Yes Yes
WXGA 1280x768 5/3 Yes Yes 2048x1152 16/9 Yes Yes

SWXGA 1360x768 16/9 Yes Yes

1366x768 1366x768 16/9 Yes Yes

WXGA2 1280x800 16/9 Yes Yes

SWXGAP 1366x800 5/3 Yes Yes

1152x864 4/3 Yes Yes

900p 1440x900 16/10 Yes Yes

1440x900 3/2 Yes Yes

1600x900 16/9 Yes Yes

1280x960 4/3 Yes Yes

SXGA 1280x1024 5/4 Yes Yes

1360x1024 4/3 Yes Yes

SXGAP 1400x1050 5/3 Yes Yes

4.6 Input specifications

The SmartMatriX? offers 10 seamless inputs. Some inputs contain several plugs.
A plug corresponds to a socket or connector on the rear panel.

The following types of plugs are available on the rear panel:

- HDBaseT (only for Ref. SMX250-H)

- HDMI®

- Single DVI-D (HDMI®compatible),

- 3G/HD/SD-SDI (BNC),

- Universal Analog (HD-15)




4.6 Input specifications

The SmartMatriX? uses an HDMI®plug with a standard M3x0,5 mm
mounting screw above the connector. Please see the

diagram below.
This hole is occupied by a Torx10 screw when you receive @

the unit. If desired, this screw can be removed and
replaced by a compatible aftermarket HDMI®plug locking
mechanism to ensure a secure HDMI®connection. This ﬂ
threaded hole should not be left empty.

27 mm

This hole is used by a TX10 screw when you receive the unit, if you wish to use an HDMI®cable with a security
fixing screw you can take this screw off and use your own in order to insure good fixing of your HDMI®plug.

Please take a look at the accepted formats regarding the input plug type:

Plug Type Formats Signals
Universal Analog Input SDTV - EDTV - HDTV - Computer Analog SDTV - Analog EDTV - Analog HDTV - Analog Computer
DVI-D Input SDTV - EDTV - HDTV - Computer Digital SDTV - Digital EDTV - Digital HDTV - Digital Computer
HDMI Input SDTV - EDTV - HDTV - Computer Digital SDTV - Digital EDTV - Digital HDTV - Digital Computer
HDBaseT Input SDTV - EDTV - HDTV - Computer Digital SDTV - Digital EDTV - Digital HDTV - Digital Computer
3G/HD/SD-SDI Input SDTV - HDTV Digital SDTV - Digital HDTV

WARNING: Only the video and audio signal is processed for the HDMI®, and 3G/HD/SD-SDI inputs; other
embedded auxiliary features are not supported or passed through. The embedded audio is processed. All
other HDMI® features such as: HDMI®Ethernet Channel, Audio Return Channel, 3D, 4K, Content Type, Deep
Color and x.v.Color are NOT supported.

The SmartMatriX2-H (only for Ref. SMX250-H) is equipped with two HDBaseT input connectors.

In addition of the management of the embedded audio streams, the HDBaseT inputs also support the Ether-
net pass-through and the Power Over Ethernet (PoE+ with 48V and 30W) functionalities.

The following table indicates the LED status of HDBaseT inputs plugs:

Link Status HDMI Status

¢HDBT”
(PoE+)

Status LINK (green color) HDMI (orange color)
LED off No Link No HDMI Video
Low Blink Ethernet Fallback Mode Not Applicable
Medium Blink Low Power Mode without Ethernet HDMI content without HDCP encryption
Fast Blink Low Power Mode with Ethernet Not Applicable
LED on HDBaseT Link HDMI content with HDCP encryption
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4.6 Input specifications

Each input can display only one active plug at a time. It is instantly available on the device and can be dis-
played simultaneously on many layers or outputs, with different sizes and positions.

Standard 3G-SDI HDMI HDBaseT
NTSC 525/480i Yes Yes Yes Yes No
PAL 625/576i Yes Yes Yes Yes No
SECAM 625/576i Yes Yes Yes Yes No
EDTV 480p 525/480p Yes No Yes Yes Yes
EDTV 576p 625/576p Yes No Yes Yes Yes
HDTV 720p 1280x720 Yes Yes Yes Yes Yes
HDTV 1035i 1920x1035 Yes Yes Yes Yes Yes
HDTV 1080i 1920x1080 Yes Yes Yes Yes Yes
HDTV 1080p 1920x1080 Yes Yes Yes Yes Yes
HDTV 1080sF 1920x1080 Yes Yes Yes Yes Yes
HDTV 1080p 1920x1080 Yes Yes Yes Yes Yes
HDTV DCDM 2048x1080 No Yes No No No
VGA 640x480 Yes No Yes Yes Yes
800x480 800x480 Yes No Yes Yes Yes
WVGA 848x480 Yes No Yes Yes Yes
SVGA 800x600 Yes No Yes Yes Yes
1280x600 1280x600 Yes No Yes Yes Yes
720p RGB 1280x720 Yes No Yes Yes Yes
XGA 1024x768 Yes No Yes Yes Yes
WXGA 1280x768 Yes No Yes Yes Yes
SWXGA 1360x768 Yes No Yes Yes Yes
1366x768 1366x768 Yes No Yes Yes Yes
800p RGB 1280x800 Yes No Yes Yes Yes
SWXGA+ 1366x800 Yes No Yes Yes Yes
1152x864 1152x864 Yes No Yes Yes Yes
900p RGB 1440x900 Yes No Yes Yes Yes
1600x900 1600x900 Yes No Yes Yes Yes
960p RGB 1280x960 Yes No Yes Yes Yes
SXGA 1280x1024 Yes No Yes Yes Yes
1360x1024 1360x1024 Yes No Yes Yes Yes
DILA4/3 1364x1024 Yes No Yes Yes Yes
SXGA+ 1400x1050 Yes No Yes Yes Yes
WSXGA+ 1680x1050 Yes No Yes Yes Yes
1080p RGB 1920x1080 Yest! No Yes! Yest Yest
2K 2048x1080 Yest No Yes! Yest Yes*
Q WXGA 2048x1152 Yes! No Yes! Yes! Yes!
UXGA 1600x1200 Yes! No Yes! Yes! Yes!
WUXGA 1920x1200 Yest No Yes! Yest Yes*

Note:

1) Reduced Blanking




4.7 Output specifications

4.7 Output specifications
4.7.1 Standard output for Ref. SMX250

The SmartMatriX? (SMX250) has two standard outputs.

The standard output contains:

- Analog Computer/Video (HD15),

- HDMI output over a DVI-I connector or DVI-I output (DVI-Analog and DVI-Digital).

:!:!!1:‘1 )‘
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Please see the formats available on the output:

Output Type Format Signal
] HDTV Analog HDTV
Analog Computer/Video Ouput Computer Analog Computer
HDTV Digital HDTV
DVI- Output Computer Digital Computer

Please note that SDTV and EDTV are not available on the standard output but only on the video output module.

4.7.2 Standard output for Ref. SMX250-H

The SmartMatriX?-H (SMX250-H) has two standard outputs.
The standard output contains:

- HDMI connector,

- HDBaseT connector.

Link Status HDMI Status

RX Tx

-
-
[*4
w
]

PROGRAM / OUTPUT #1

Status LINK (green color) HDMI (orange color)
LED off No Link No HDMI Video
Low Blink Ethernet Fallback Mode Not Applicable
Medium Blink Low Power Mode without Ethernet HDMI content without HDCP encryption
Fast Blink Low Power Mode with Ethernet Not Applicable
LED on HDBaseT Link HDMI content with HDCP encryption

The IR and Serial connectors associated to the HDBaseT connector are described in section 4.8.4.
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4.7.3 Video output

4.7.3 Video output

The SmartMatriX? has one video output.

This video output contains:

- 3G/HD/SD-SDI (BNC),

- Analog SDTV (4 x BNC: Composite, YC, YUV, RGBS).

3G/HD/SD-SDI
VIDEO OUT

Please see the output formats of the monitoring output:

Output Type Format Signal
Video Y/C Output SDTV Analog SDTV
Video Y Pb Pr Output SDTV Analog SDTV
Video RGBSTTL Output SDTV Analog SDTV
SDTV Digital SDTV
SD-HD-3G-SDI Output HDTV Digital HDTV
Cinema DCDM - 2K

4.8 Communication specifications
4.8.1 Serial interface

A standard RS232 interface is available through a DB9 female connector:

- It permits controlling the device

- It permits updating the device

Data Rate: 1200 to 115200 Bauds, 8 data bits, 1 stop bit, no parity bit, no flow control by default.
DTR & RTS needed for firmware upgrade.

4.8.2 LAN interface

A standard LAN interface is available through a RJ-45 connector
- It permits controlling the device

- It permits transferring configuration

- It permits connectivity with the RCS? application

- It permits updating the device

4.8.2.1 Protocol

Protocol Availability

TCP Yes
UDP Yes

4.8.2.2 IP address

Address allocation Availability

Static user defined address Yes

Default IP address: 192.168.2.140
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4.8.3 Video output

4.8.3 HDBaseT LAN interface

The HDBaseT input and output connectors of the SmartMatriX?-H (SMX250-H) can manage the Ethernet
passthrough. A specific LAN over HDBaseT connector is available on the SmartMatriX?-H to be connected to
the dedicated network.

LAN OVER

HDBT

The HDBaseT LAN cannot be used to manage the device.
4.8.4 IR and SERIAL HDBaseT interface

Associated to each HDBaseT output connectors, the 5-pin MCO connector can passthrough the one-way
InfraRed and the Bidirectional Serial RS232 signals to the HDBaseT output interface.

The pins #1 to #3 are used for the HDBaseT Serial RS232 connection, respectively for the transmission (TX),
the reception (RX) and the Ground RS232 signals.

The pins #4 and #5 of the MCO connector are dedicated for the HDBaseT IR signal, respectively for the
reception (RX) and for the Ground signals.

Please note that some IR sensors could have a low power signal which could not be compatible with the
expected IR input characteristics of the Midra™. In case of issue, make sure to use professional IR controller.




4.9 Environmental specifications

4.9 Environmental specifications

For SMX250:

Dimensions: Weight:

» D 15.75”’x W 19”” x H 3.46” with rack mount and handles
» D400 mm x W 483 mm x H 88 mm

» 6,3kg/13.91b

(Compatible with a Standard 19”
rack, Height = 2 U)

> D 14.17”"x W 17.3” x H 3.46" without rack mount and handles
» D360 mm x W 440 mm x H 88 mm

¢ Cooling air flows from right side to left side.

e Max ambient operating temperature: < 40°C (< 104°F).

¢ Operating temperature: 0 to +40°C / +32°F to +104°F

e Storage temperature: -40 to +70°C / -40°F to +158°F

® Operating humidity: 10 to 80% (non condensing)

e Input voltage range: 100-240 VAC autosensing, 50/60 Hz
e Typical consumption: 110 W

ELECTRICAL SECURITY:

¢ |[EC 60950-1:2005 (2nd Edition); Am 1:2009

e EN 60950-1:2006 + A1:2010 + A11:2009 + A12:2011, CSA C22.2; National Differences specified in the CB
Test Report

e UL listed (Canada & US)

ELECTROMAGNETIC COMPATIBILITY:
¢ |[EC 61000-3-2 (2009)

* |[EC 61000-3-3 (2008)

¢ CISPR22 (2008)

¢ CISPR24 (2010)

® FCC Part15 of 2012

¢ |[ECS-003 of August 2012

ENVIRONMENT:
® RoHS
e WEEE

USE/TRANSPORT:

e ETS 300 019-2-2: Environmental conditions and environmental tests for telecommunications equipment ;
Part 2-2 : specification of environmental tests ; Transportation ; Specification T 2.3: Public transportation

¢ ETS 300 019-2-3: Environmental conditions and environmental tests for telecommunications equipment ;
Part 2-3 : specification of environmental tests ; Stationary use at weather protected locations ; Specification
T3.1and T 3.1 E: Temperature-controlled locations

A If your device should lose power unexpectedly, you may lose any unsaved settings.
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4.9 Environmental specifications

For SMX250-H:

Dimensions: Weight:

» D 18.70”x W 19” x H 3.46"’ with rack mount and handles
» D475 mm x W 483 mm x H 88 mm

» 7,5kg / 16.31 b

(Compatible with a Standard 19”
rack, Height = 2 U)

» D 17.71”"x W 17.3” x H 3.46” without rack mount and handles
» D450 mm x W 440 mm x H 88 mm

e Cooling air flows from right side to left side.

e Max ambient operating temperature: < 40°C (< 104°F).

e Operating temperature: 0 to +40°C / +32°F to +104°F

e Storage temperature: -40 to +70°C / -40°F to +158°F

® Operating humidity: 10 to 80% (non condensing)

e Input voltage range: 100-240 VAC autosensing, 50/60 Hz
e Typical consumption: 160 W (with 2x24w PoE)

ELECTRICAL SECURITY:

¢ |[EC 60950-1:2005 (2nd Edition); Am 1:2009

e EN 60950-1:2006 + A1:2010 + A11:2009 + A12:2011, CSA C22.2; National Differences specified in the CB
Test Report

e UL listed (Canada & US)

ELECTROMAGNETIC COMPATIBILITY:
¢ |[EC 61000-3-2 (2009)

* |[EC 61000-3-3 (2008)

¢ CISPR22 (2008)

e CISPR24 (2010)

e FCC Part15 of 2012

¢ |[ECS-003 of August 2012

ENVIRONMENT:
e RoHS
o WEEE

USE/TRANSPORT:

e ETS 300 019-2-2: Environmental conditions and environmental tests for telecommunications equipment ;
Part 2-2 : specification of environmental tests ; Transportation ; Specification T 2.3: Public transportation

e ETS 300 019-2-3: Environmental conditions and environmental tests for telecommunications equipment ;
Part 2-3 : specification of environmental tests ; Stationary use at weather protected locations ; Specification
T3.1and T 3.1 E: Temperature-controlled locations

A If your device should lose power unexpectedly, you may lose any unsaved settings.
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4.10 HDCP management

4.10 HDCP management
4.10.1 Input HDCP detection

The input HDCP detection is managed by the input components according to HDCP specification.

4.10.2 Output HDCP detection

The SmartMatriX? manages the output HDCP detection according to one of the following criteria:
- Hot plug,
- 3-second period attempt.

4.10.3 Keys’ checking

Keys’ checking is performed according to the most restrictive condition among the 2 following ones:
- Every 2 seconds
- Every 128 frames

4.10.4 Output management

HDCP protected content can be displayed only on HDCP protected outputs or displays. Therefore, whenever
an HDCP protected source is placed into a layer routed to a non-protected output, the SmartMatriX? will not
output the protected content on this non-protected output, and the layer will be grayed.

If possible, the SmartMatriX? will allow to display all other non-protected contents, otherwise the entire
output will be muted until the protected content is no longer routed.

4.10.5 HDCP Classification

Class Support

HDCP Receiver Yes
HDCP Transmitter Yes
HDCP Repeater No

HDCP Receiver
The HDCP negotiation can be enabled or disabled on all HDCP inputs.

HDCP Transmitter

The HDCP negotiation can be enabled or disabled on all HDCP outputs.
The SmartMatriX? can manage HDCP repeaters on its outputs: up to 32 display devices can authenticate
simultaneously on each output.

4.10.6 Status

In order to permit quick identification of all the HDCP operations on the device, the SmartMatriX? provides a
full set of status summary to help the user with the HDCP management:
- A front panel menu that displays all the general HDCP status of all inputs and outputs

h



5.1.1 Rear panel SmartMatriX? - Ref. SMX250

—O 5. CONNECTING THE SMARTMATRIX?

5.1 Description
5.1.1 Rear panel SmartMatriX? - Ref. SMX250

) D

-4 @ ‘]j | @ Y@'\W
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. Power supply: 100-240 VAC 2.5A 50/60HZ / FUSE F4A 250 VAC; internal, autoswitchable; 110W
. 3G/HD/SD-SDI: inputs #1 to #4

. S/PDIF: audio inputs #1 to #2

. MCO male connector: for audio inputs (balanced) #1 to #4

. MCO male connector: for audio outputs (balanced) #1 to #2

. S/PDIF: audio outputs #1 to #2

. Video out connectors: -1 x BNC-F: 3G/HD/SD-SDI (with audio embedded)
- 3 x BNC-F: Y-Cb-Cr
- 1 x BNC-F: Composite video PAL/NTSC

8. Universal Analog Computer TV/HDTV: inputs #1 to #4

N O U pA W N R

9. DVI connectors: DVI-D inputs #1 to #4. Capability to receive digital audio signal from HDMI®connector via
an adaptor (HDMI-compatible)

10. Ethernet plug

11. HDMI®connectors: HDMI®inputs #3 to #6. Digital audio compliant

12. Communication port: communication port with DB9 female connector

13. Universal Analog Computer TV/HDTV: HD15 outputs #1 to #2

14. DViconnectors: DVI-loutputs#1to#2. Capability totransmit digital audio signal towardsa HDMI®connector

via an adaptor (HDMI-compatible)
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5.1.2 Front panel SmartMatriX? - Ref. SMX250

5.1.2 Front panel SmartMatriX? - Ref. SMX250
1 2 3 4 5

LAYER SELECTION ——————————ay ADJUSTMENT

[W]ANALOG WAY® ‘

INPUT SEEECTIH & sty
m m ‘
J i

LF1 LF2 LF3 LF4

CONTROL ———~

| [
SmartMatriX* f =2 =
] o LF5 LF6

DI
LF7 AILF8

SMX250

1. Front panel display: 4-line VFD
2. Menu scroll knob

3. Layer selection: - Frame: un-scaled layer for still frames
- Layer A/B: scaled positionable layers for live sources
- Logo 1: un-scaled, positionable layer for still logos

. Matrix mode: #1 to #2: select the output #1 or #2, a layer and a source, then press TAKE
. Adjustment: adjust layer or logo position, size active layer, zoom active layer
. On/Off - Stand-by: hold for 3 seconds for stand-by mode

. Control: Exit/menu: Home menu or back one level - Enter: validate the menu or command

00 N O U b

. Input selection: -1 to 4: access source 1 to 4, display frame/logo 1 to 4
- HDMI®1/2: access HDMI®1 or HDMI®2
- SDI 1 to SDI 4: access SDI 1 to SDI 4, display frame/logo 5 to 8
- Quick Frame: allows to quickly display a foreground frame

9. Shortcut: Effect: shorcut to transition menu - Preset: recall a custom stored preset

10. Layer: - Black: clear the layer
- Freeze: freeze/unfreeze the input selected in the currently selected layer

11. Step Back: recall the last preset

12. TAKE: transition the pre-selected sources onto the Program output with the selected effects




5.1.3 Rear panel SmartMatriX-H - Ref. SMX250-H

5.1.3 Rear panel SmartMatriX?-H - Ref. SMX250-H
1 2 3 4 5 6 7

SDI # SDI #2

MADE IN E.U.
MODEL : SMX250-H

8 9 10 11 12 13 14 15 16 17

. Power supply: 100-240 VAC 2.5A 50/60HZ / FUSE F4A 250 VAC; internal, autoswitchable; 155W
. 3G/HD/SD-SDI: inputs #1 to #4

. S/PDIF: audio inputs #1 to #2

. MCO male connector: for audio inputs (balanced) #1 to #4

. MCO male connector: for audio outputs (balanced) #1 to #2

. S/PDIF: audio outputs #1 to #2

. Video out connectors: -1 x BNC-F: 3G/HD/SD-SDI (with audio embedded)
- 3 x BNC-F: Y-Cb-Cr
- 1 x BNC-F: Composite video PAL/NTSC

8. HDMI connectors: HDMI inputs #1 and #2 / HDMI #1 and HDMI #2

N OO o1 A W N

o

. HDBaseT connectors: HDBaseT inputs #1 to #4

10. DVI connectors: DVI-D inputs #3 and #4. Capability to receive digital audio signal from HDMI connector
via an adaptor (HDMI-compatible)

11. Universal Analog Computer TV/HDTV: inputs #3 and #4

12. HDBaseT ethernet connector: HDBaseT LAN interface

13. Ethernet connector: LAN control for device management

14. HDBaseT connectors: HDBaseT multi-plug outputs #1 and #2

15. HDMI connectors: HDMI multi-plug outputs #1 and #2

16. Communication port: communication port with D89 female connector

17. 5-PIN MCO male connectors: HDBaseT 5-pin MCO multi-plug output #1 and #2 for InfraRed and Serial

HDBaseT communication signals

uﬂ



5.1.4 Front panel SmartMatriX?-H - Ref. SMIX250-H

5.1.4 Front panel SmartMatriX2-H - Ref. SMX250-H
1 2 3 4 5

LAYER SELECTION ————————— MATRIX MODE —— ADJUSTMENT
I Layer [N Laver M Logo | . ]

| Layer Layer Logo.
2 |
INPUTSELECTION ~———e———e—————

B N R

!_ 1 —! [ 2) ’ ‘ 3 | 4 HOMI 1
(W (S| (N N —

LF1 LF2 LF3 LF4

SHORTCUT ————

N (N (RN N N N
soi1 |l sor 2 [ spis ’SDM[ HI Effect | Preset
S W (RN e e | AR
LF5 LF6 "

LF7 ALF8

SMX250-H

1. Front panel display: 4-line VFD
2. Menu scroll knob

3. Layer selection: - Frame: un-scaled layer for still frames
- Layer A/B: scaled positionable layers for live sources
- Logo 1: un-scaled, positionable layer for still logos

. Matrix mode: #1 to #2: select the output #1 or #2, a layer and a source, then press TAKE
. Adjustment: adjust layer or logo position, size active layer, zoom active layer
. On/Off - Stand-by: hold for 3 seconds for stand-by mode

. Control: Exit/menu: Home menu or back one level - Enter: validate the menu or command

00 N O U b

. Input selection: -1 to 4: access source 1 to 4, display frame/logo 1 to 4
- HDMI®1/2: access HDMI®1 or HDMI®2
- SDI 1 to SDI 4: access SDI 1 to SDI 4, display frame/logo 5 to 8
- Quick Frame: allows to quickly display a foreground frame

9. Shortcut: Effect: shorcut to transition menu - Preset: recall a custom stored preset

10. Layer: - Black: clear the layer
- Freeze: freeze/unfreeze the input selected in the currently selected layer

11. Step Back: recall the last preset

12. TAKE: transition the pre-selected sources onto the Program output with the selected effects




6.1 RCS? requirement

—O 6. CONTROLLING THE SMARTMATRIX?

The SmartMatriX? can be controlled and operated either via the Front Panel, from your computer via the
RCS?, or via one of our Event Controllers. (Control of the SmartMatriX? can also be integrated into automation
and control systems, contact your local technical support for more details.)

6.1 RCS? requirement

The recommended requirements are: Operating system:

- Adobe Air® - Windows XP SP3 or above
- 1Gb Ram - Mac OS v10.7 or above

- 200Mb of free space - Ubuntu v10 or above

- 100Mb Network adaptor or above - Linux OS 11 or above

- 1920x1080 optimized screen resolution
- 1366x768 as the minimum screen resolution.

For Linux users:

The RCS?is an Adobe® AIR® application that requires the most recent version of this runtime. As Adobe® AIR®
is no longer supported for desktop Linux distributions, please use a dedicated software such as WINE to use
applications designed for Microsoft Windows on your operating system.

1. First, install a Microsoft Windows compatibility layer software on your Linux PC.

2. Then install the Adobe® AIR® last release using your emulator

3. Finally, install the RCS? using your emulator.

You are ready to use the RCS2.

6.2 Connecting with the RCS?

The RCS2 is an Adobe Air application that runs on your computer. Before you can
. connect to your device, you must first download and install Adobe Air, then download
and install the RCS2 on your computer.

In order to connect the RCS2 to the device, you need to use a LAN connection. Use a

crossover cable if you connect your computer directly to the unit, or use straight cables if you are connecting
through a switch or hub.

Before switching ON the unit, please plug a LAN cable on the rear |l ClonLr 20
panel into the Ethernet port. Then switch ON the unit. General
‘fou can get IP settings assigned automatically if your networl_< supports
By default, the network settings on the SmartMatriX? are e e ]
Default IP Address: 192.168.2.140 s
Ohbtain an IP address automatically
Default Subnet Mask: 255.255.255.0 (% Use the Follawing IP address:
. IP address: 192 168 . 2 . 50
Default port: 10500
Subnet mask: 255 255,255, O
To be able to connect to this address, your computer will need to B et 192 168 2 . 1
be configured to use a unique IP address on the same network. If " Cbtain DI server adchess automatizally
this setup will be part of a larger network with other devices, please 7 Use the Following DS server adresses:
. .. . Preferred DNS server: 192 168 . 2 . 1
check with your network administrator before plugging these
. . i ) Alkernate DNS server: 192 168, 2 . 1|
devices into the network to avoid any IP address conflicts.
For example, you could assign the following static IP address to your WAL _Advonced.._ |
computer: e ==

Example Computer IP address: 192.168.2.50
Example Computer Subnet Mask: 255.255.255.0

To download the Remote Control Software, please visit our website and go into the product section. Then,
into the download link, please download the RCS? associated to your product. Install it and then open. Here
is the startup screen.

‘4



6.2 Connecting with the RCS?

Enter the IP address of the device and then the remote port.
Click on Connect to start the connection. m

CONNECT YOUR DEVICE

ddress [INI92 168 2 140

v02.0.03 BETA

Once connected, you have access to this screen:

| —
SCREEN 1
ANALOG WAY 1920x 1080

[S1]PGM

E

[S11PRW
] o Click one layer to enable this view

TAKE

ONE SHOT

In case of difficulties:

- Verify that you are using the correct network cable and that it is free from defects. (Crossover or straight
cable as required.)

- Check the IP address of both the device and the computer. It must have a unique IP address on the same
network as your SmartMatriX2. You may need to manually configure a static IP address for your computer
in your computer’s network configuration.

-You may need to temporarily disable any other networks on the computer, such as turning off the wifi
connection.

- Close the RCS?.

- Restart the RCS2.

Once your computer has established connection, the RCS? control panel will begin to load, and will begin to
synchronize with the device. When the small “Sync” icon at the bottom right of the display has turned green,
the RCS? software is ready to use.

riods of inactivity. To avoid the inconvenience of reconnecting the software during use, please

Some computers use an energy saving mode that turns off the network adaptor during pe-
A ensure your network adaptor remains active by disabling the energy saving mode.

h-



6.3 RCS? top menu

6.3 RCS? top menu

6.3.1 Setup

The Setup page is where you will review and modify the device configuration, such as output resolutions,
input settings, and more.

6.3.2 Edit

The Edit mode is the place where you will manage preset creation. You will make input selections, manage your
inputs, adjust the layer attributes such as size, position, effect, etc. You can save all your screen configurations
into presets, as well as review and recall them on each individual screen.

6.3.3 Live

The Live mode is the section where you will operate your show. You can quickly recall presets or make input
selections, as well as setup a sequence of presets that can run continuously with custom durations, or wait
for user interaction.




7.1 Operating mode

7. OPERATING THE SMARTMATRIX? FROM THE RCS?

7.1 Operating mode

Before you start setting up your SmartMatriX? for the first time, take some time to think about how you will
be using it. The SmartMatriX? offers one operating mode, which results in a versatile video production tool
for live event staging and fixed installation applications.

NOTE: We recommend resetting the device to its default values every time you set up your shows or events.

7.2 Setup
Go to the setup section to start to set up @
your unlt, ANALOG WAY

etul © Edit [« QT
A Setup assistant is available to help you
to correctly adjust all basic setups of
your unit.

7.2.1 Mode

The device can work in Matrix mode only.

Matrix mode

This mode turns your SmartMatriX? into a true 10 x 2 scaled matrix, while preserving seamless switching
capabilities. Program 1 and Program 2 outputs can be set to different resolutions and rates. Switching between
any of the inputs can be done with the various effects (Cut, Fade, Slides...) and synchronized on both outputs.

Background

Frame

nd
Layer A Foreg !

Layer B

L0go

Quick Frame




7.2.2 Audio

7.2.2 Audio

<« Previous Next p-

In this section, you will setup the audio of your device, you have several modes. In all modes, you have the

Screen#1 PGM (Out #1)

Seloct your Preset mode.

Screen#1 PGM (Out #1) Screen#2 PGM (Out #2)

@

7.2.3 Screens

possibility to output the audio in AES3 or SPDIF:

NO AUDIO: the audio of your device is switched off

PRESET MODE: the standard mode of use of the device

You have two possibilities:

¢ Top layer: the sound on the output will follow the audio input of the top
layer.

e Breakaway: when breakaway is activated, the audio on the output is
memorized into the preset. A change of preset, changes the audio on the
output. A change of content into a video layer has no effect on the audio.

ROUTING MODE: in this configuration, simply choose an audio input to
assign it to the output. The audio configuration remains the same during
the show.

In this example inputl is on outl and input 2 is on out 2

- Previous Next p

Auto QuickFrame

out In the screen configuration, you will find the state of your screen. It indicates the
Resolution (1920 1080) screen resolution, the maximum number of layers you can use.

ayer:

—— You will find configuration for the Quick Frame and the background color too.
Auto Take The Quick Frame will be your emergency frame that can be displayed in front of

Quick Frame | FRAME 1

every layer. Here, select the frame slot number to be displayed as the Quick Frame.
With the SmartMatriX?, you have 2 screens status.



7.2.4 Misc

7.2.4 Misc

Screens Preview

-« Previous Next p

GENERAL SETTING In the GENERAL SETTING section, you have access to:
DYNAMIC FIT: enable or disable the automatic recognition of black band for
Dynamic it digital content. The size and the aspect ratio of the layer are automatically

adapted.
Fasmes O Famm FREEZE MODE: choose to freeze all inputs or only one input when you use
grouna coir [ 7] ‘aosto2 Al the freeze function.

PIP BACKGROUND COLOR: here you chose the automatic color of PIP

e background, black is the default color.

Mode

In the VIDEO OUT SETTING section, you have access to:
RECORDING: allow to configure the video output. Configuration shall be done in section 7.2.9.
OUTPUT#1 and OUTPUT#2 PLUGS: auto configure the video output as a copy of the output #1 and #2.

7.2.5 Output management

Into the output section, you will be able to manage your output resolutions, formats, sync types, test patterns,
etc. On the SETUP > OUTPUT TAB, the following screen will appear:

A short summary of each output settings appears on the main page. You can see the number of outputs, their
resolution, rate and HDCP status.

Select an output to adjust by either clicking on it from the column on the left, or clicking the configuration
cog icon for that output.

Once the individual output setup page is opened, you have access to:

- MODE: choose your rate generation mode,
internal (free-running within the unit) or
Framelock by choosing an input as a reference
input,

- FORMAT: choose the output resolution format,

- RATE: choose the signal timing standards, if
the mode is set to internal

- STATUS: the status menu will show you the
current output status,

- APPLY: click on this button to apply the new

format/rate,

- PLUG STATUS: indicates the status of the

attached monitor and confirms connectivity,

-TYPE: you can choose the type of output
synchronization on the analog plug, for
example RGsB for sync on green, or RGBHYV for
separate H and V sync wires,




7.2.5 Output management

- HDMI as DVI: select this box to force the output to DVI mode instead of the default HDMI®autosense mode.
When in DVI mode, no embedded audio will be transmitted,
- PATTERN: a selection of patterns is available to test your output. These patterns will override any input
selection that you might have.
You can choose from:
* No Pattern — turns the pattern off
e Vertical or horizontal Grey Bars — displays grey bars
e Vertical or horizontal Color Bars — displays color bars
e Grid — displays an 8x8 box grid pattern
* SMPTE bars — displays the SMPTE color bar pattern
e Vertical Burst — displays alternating black and white 1 pixel wide columns
e Centering — displays a 1 pixel wide dotted line at the edge of the output (only available for computer
formats)
e Vertical or horizontal gradient — displays a 0 to 100% gradient pattern.
- FLICKER: choose the value of the flicker filter to remove the flicker effect on your interlaced output screen,
- GAMMA: increase or decrease the gamma of your output,
- HDCP: enable/disable and see the HDCP status.

Depending on the output format chosen, only relevant settings will appear.

Custom format
The device offers the possibility to create your own output format:

Edit your Custom Format

General

Choose CVT mode (restricted settings) or FULL mode
(full settings) and start to create your format by
adjusting the Horizontal Vertical pixels, frame rates
and reduced blanking.

Click on CHECK to verify if your format is a valid signal.

You can SAVE and LOAD your Custom format.

7.2.6 Input management

Once your outputs are configured, you have now to configure the inputs connected to your device.
Under the inputs section, you can view your inputs by active plugs or by all plugs (active and inactive).

In both cases, an AUTOSET ALL can be launched to set up automatically your inputs.

Once the AUTOSET ALL is done, you can check one by one your inputs and see if they were correctly detected
by checking the input STATUS. The input STATUS is defined by a FORMAT and a RATE. If that information is
not available, your input has not been properly detected or set up.

‘ﬂ



7.2.6 Input management

In this case, you can enter manually into each input settings by using the left menu:

Under the SIGNAL tab, you will find:

- ACTIVE PLUG: select the plug used by the unit at the moment. Only
this plug can be displayed on your output,

Rl [ - SETUP PLUG: select the plug you want to set up, all changes will
be applied to this plug, even if this plug is active or not (do not
mismatch with the active plug),

- SIGNAL TYPE: define the type of your signal, video SD/HD YUV/RGB
or Computer HV/SOG etc.,

- ENABLE: enable/disable the input,

- REF SYNC: affect the input to the ref sync input. Use this box only
if your source is genlocked with the referenced source (framelock

image  Aspect UserFormat  Keying

Auto Detect

n feature),
BT - LABEL: rename your input according to your source,
- AUDIO MAPPING: select the audio input that will be linked with the
video input,

- EMBEDDED SIGNAL AUDIO: status indicates if an embedded audio signal is detected or not,
- STATUS: format and size of the input.
For the HDBaseT input, the status also provides the Signal Quality of the HDBaseT link.

Signal Quality (MSE) MIN B I
MAX B I

- CONTROL: Black: select Black to transform your input in a uniform color,
Freeze: use this button to freeze the specific input,
- EDID: choose the EDID for the selected plug. Change EDID Preferred Format *

Under the HDCP section, you can:

- Enable/disable the HDCP communication feature

- Read the HDCP status, If the HDCP status says Active, this input connection is
currently utilizing HDCP to protect the signal. if the HDCP status indicates Idle,
this input connection is currrently not utilizing HDCP.

Next is the IMAGE tab, where you can find all settings about the display of your input:
Under the COLORIMETRY section, you have:

COLORIMETRY
Input 2

Brightness i
Input 3 Contrast |l
o
Input 4
SHARPNESS
Level Low
Input 5

USER GAIN

Input 6

Input 7

- BRIGHTNESS: define the selected input luminosity level,
- CONTRAST: define the selected input contrast level,
- COLOR: define the selected input color level (0:black and white, full: full color),

h



7.2.6 Input management

Under the SHARPNESS section, you find:
- LEVEL: define the selected input luinosity level.

Under the USER GAIN section, you find:
- RED/GREEN/BLUE: increase/decrease the Red/Green/Blue level of your input.

Next you have the ASPECT tab. All settings about the blanking and aspect ratio are available there:

BLANKINGS ADJUSTMENTS

H Position 0

For the analog inputs, the blanking section is available.

Under the BLANKING ADJUSTMENTS:
- H&V POSITION SIZE: you can manually adjust the input blanking with the H&V size or position.

N N ~ ~ ~ -

redefined Crof

e e e ne he.

Letterbox 1.78  Letterbox 1.85  Letterbox 2.35 Pillarbox

cled)e. @0,

Under the ASPECT RATIO section:

- ASPECT IN: forces a particular aspect ratio for the source. (5:4, 4:3, etc). This setting has no effect when set
to native,

- PREDEFINED CROP: choose a specific cropped ratio if you use a source with black bands on top/bottom or
left/right,

- ASPECT OUT: define the way the image will be displayed into a layer (full screen, centered, cropped or 1:1),

- OVERSCAN: choose to apply or not a predefined zoom on the image (use with video signal).

Under the CROP section:
- TOP / BOTTOM / LEFT / RIGHT: use the Top, Bottom, Left and Right values to crop your input.

The next tab is the USER FORMAT:

In this tab, you can explicitly define the input format. The input format is automatically detected by the
SmartMatriX? but you can change it or force it. The available formats are close to the current one, in terms
of lines. This is only available for analog computer formats.

Keying Feature

General Signal  Image  Aspect User Format

Keying Setup

Input 2

- - . ll ”_]
Input 3 3 ’

DSK/TITLING
Input 4




7.2.6 Intput management

With the keying feature, you will be able to key easily a color space or a specific luma on an input.
The device offers an individual keying for each input. Into the input settings, find the keying menu:
You have 2 ways of using the keying:

- COLORKILLER: classic color keyer removing a specific color space defined by user,

- LUMAKILLER: luma keyer removing a specific lumanance level range.
Keying Setup

“N O g

Tolerance .

Luma Low Level |0

Luma High Level

Chroma Setting Manual Grabber n
Current Color E #00FF00 ®

DSK i TITLING

Enable

Keying setup can be done either by setting directly color references and tolerances or by using the color grab
assistant.
@x - INVERT BUTTON: at any time you can choose to invert the actual keying using this button.

4

DSK TITLING: after your keying, the DSK titling feature allows you to play with the transparency of your
deleted pixels. Enabling this, simply adjust the opacity settings to make your keyed pixels less or more dark.
This is useful when keying white or light colored text over a bright background.

How to use the LUMA KEY:
Select the lumakiller and then adjust manually, the luma level:

Luma Low Level |o

- Manually: set the minimum luminance value.

Luma Low Level: Everything darker than this value will be keyed away.

Luma High Level: Everything brighter than this value will be keyed away.

Then adjust the maximum luminance value to define the range of luminance levels which will be deleted.
Once you have completed the setup of your keyed input, place the it in layer B on top of your background
(such as a camera in layer A) in order to complete the keyed title or lower third effect.

How to use the CHROMA KEY:

- Manually: set the Hue and luminance to choose the color space you want to delete into your image.
Set it manually looking at the color change into Current color. If you want, you can quickly select a color from
a color panel, clicking on CURRENT COLOR. Then click on the color itself to obtain the color panel. Once
your main color is chosen, you can define a degree of tolerance around this color. The tolerance will define,
around the main color, an area that will be keyed too. You may still need to make further adjustments to the
luminance level to complete your key effect.

- Grabber: activate the grabber to grab the color you want to key. Move the cursor and click on the grab
button to grab the color.

h



7.2.7 Logo management

7.2.7 Logo/frame management

To save a logo/frame click on this button:

=
m
iy Copture st

The next page opens.

From here you can capture from the main or from the Preview.

You can still freeze the output before saving your logo/frame.

You can also utilize the logo keying feature to key away part of the image before saving the logo.

Capture LOGO 1 x
Program Preview *- FREEZE

Position Size Adjust Keying Set up

“mEa g

BackGround Color BLACK

EXECUTE

Select the area you want to save using the adjustable white square.
Once it is ok, simply click on execute to save the logo.

How to save a frame:

Choose first Program or Preview, click on FREEZE if you want to freeze your output. Then click on EXECUTE to
save your frame into the selected slot.




7.2.8 Video out

7.2.8 Video out

The configuration of this sectionis only available if the VIDEO OUT SETTING mode has been set to “RECORDING”
in the Preconfig > MISC section.
Into this section, choose the output format of the video output.

SDTV PAL

Current Format SDTV PAL L¥ 4
Resolution 720 x 578
CurrentRate  50.00Hz

Plug YPbPr VALID

Plug CVBS VALID

Plug SDI VALID

Apply | click to apply Rate and Format

CONTROL

= LEE

Centering Pattern

You will find the status of your output and the possibility to choose the test pattern. In addtition, you can

adjust:

- FLICKER: choose the value of the flicker filter to disabled the flicker effect on your screen (interlaced lines
effect),

- GAMMA: increase or decrease the gamma of your output,

Then you will be able to configure the Layout:

- LAYOUT: configure the layout by selecting either
OUT #1, OUT #2 or a mix of OUT #1 and OUT #2.

- BACKGROUND COLOR: select the color of the
background,

- OVERSCAN: enable/disable the overscan/
underscan,

- SHARPNESS: adjust the sharpness of the image.

You can still play with the H/V position and H/V size in order to adjust accurately the video out image on your
final screen.




7.2.9 Audio management

7.2.9 Audio management

The audio section permits the management of level, balance, and other audio settings for each input.

© Eait
(.|

OUTPUTS

©Q Live

==

PRECONFIG

-

LOGOS

only Current

Out #2
W) )

) <)
INPUT 1 HDBASET INPUT 2 HDBASET

INPUT 1 INPUT 2
ANALOG ANALOG

@0dBFS
Analog level

@0dBFS
Analog level
. 10 :, 10

45 -
o .l\ﬁaau

4

0’ +15dBu

VIDEO OUT

)
NPUT 3
ANALOG

Gain
i, 0°

,ﬁe@

*(+4dBu)
4

Mono

Pan
L R
0

Before modifying the audio settings, be sure to check the audio
input mapping. Each video input has one audio source mapped to
it. The audio mapping configuration is found under Menu > Inputs

> each input.

Filter your Audio inputs X ‘

M ALLINPUTS

All analog Inputs

input 1 analog input 2 analog input 3 analog input 4 analog

rliealﬂ

CE

SERVICES

W) ) ) )

INPUT 4 INPUT 3 DVI INPUT 4 DVI INPUT 1 HDMI
ANALOG

INPUT 2 HOM|

Rate Rate Rate Rate

Gain
s, 0°

*(+4dBu)
4

Mono Mono Mono Mono
Pan

Pan Pan Pan
L R L R l R
0 0 0

R L
0

+6

+3

i =

3

5

2= B=

-20

-30
-50
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Audio Mapping

Audio Source EMBEDDED

[EweebpeD
Embedded Audio § ANALOG 1

ANALOG 2

ANALOG 3

ANALOG 4

SIPDIF 1

Audio Signal

STATUS

Into the AUDIO SETTINGS:

To display only the Current audio input which is played,
click on Current button.

input3dvi M input 4 dvi

All HDMI

input 1 hdmi M input2hdmi M input5hdmi M input6 hdmi

If you want to select which audio input will be displayed,

click on the list button =then select the input audio
source you want.

AllHDBT

B input 1 hdbaset input 2 hdbaset input 3 hdbaset input 4 hdbaset

input 7 sdi input 8 sdi input 9 sdi input 10 sdi

All SPDIF

i input spdif 1 input spdif 2

Cancel Save
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INPUT 1
ANALOG

7.2.9 Audio management

To setup your analog audio input, simply click on “ON PRELIST”, if you have a Preview output,
the audio input will be played on it. Then adjust the GAIN from -11 to +6dB.

A red indicator light will be displayed if you reach the input clip. If the input clip light is being
illuminated, it means that the input gain is too high and the signal is being distorted. To solve this
issue, decrease the gain value. The 0dB corresponds to a +4dBu signal in input.

The gain manual adjustment is only available for analog input.

For every input, you have the possibility to set up your source as a mono audio or stereo audio
source.

You have the possibility to adjust the level vs right level using the Pan knob.

All input still have their own level which is 0 by default, decrease or increase the value to modify
the sound level:

Audio Group Specific feature:

-

Grp A

- DIGITAL SOURCE: all digital sources will have their sample rate displayed,
STINMRSTIN - SDI SOURCE: on SDI source you can choose 2 channels on one of the 4 groups.

Out #1 Out #2

o)

0 The available audio output controls depend on the device

INPUT 1 HDBASET INPUT 2 HDBASET

setup configuration. As you are in matrix mode, you will have
2 programs audio outputs.

For the audio output, you will find:

- ALEFT/RIGHT PAN ADJUSTMENT

- A GAIN ADJUSTMENT: this setting will help you to calibrate
the analogaudio output component. Depending onthe device
you will use after the analog way device, adjust carefully the
analog gain. Basically, for a O level, the default value is 4 dBu.

- A MASTER LEVEL: it indicates the level of your input. On its
right, a bar will move up and down to indicate the audio level

in real time. A red button will turn on if the maximum level

A Ve Aaing vt is reached.

8 - A DELAY ADJUSTMENT: the delay can be automatically
calculated or manually adjusted. To adjust it manually, first
disable the Auto button.




7.2.10 Service management

7.2.10 Service management

EXPORT BACKUP FILE In the Service section, you will find the following tools:
Local Presats (8-64) IMPORT / EXPORT: Export or locally import the Local Presets, the Thumbnails and
Thumbnails the Shortcuts.
e TEMPERATURE and HARDWARE INFO: Provide the status of the FPGA and boards via
EXPORT alarm tabs.

TECHNICAL SUPPORT: Display the different technical support contacts depending on
your area.

IMPORT BACKUP FILE
Local Presets (9-64)
Thumbnails

Shortcuts

Upload...

7.2.11 Control management

In this menu, all specific settings, which cannot be sorted under the other menus, are listed:

Network
T The interface loaded into the unit uses the IP configuration.
MAC Address 00.80 A3-BA17.01 Under INTERFACE, you can define a new:
- IP address
- Netmask
e e ' ' ' - Port: choose the port

10500

Erase Memories Apply

EDID
Under this section, you can manage the EDID library, and configure the EDID inputs if needed by dragging and
dropping from the EDID Library section to the inputs.

1. Outputs EDID 2. EDID Library ? 3. Inputs EDID Setting

OUTPUT 1 Lo £ INPUT 1

ANW6100 ANW6101 ANWE102 —
= IVM611D n n n _' ANWE102

HOMI e
HDMI 14 MDR_EDID_ANA 2 MDR_EDID_D — 3 MORE

B anwet02

3 MDR_EDID_HOM

Functions

Erase Memories INPUT 2

OQUTPUT 2
ANW6102

=  [VM611D
Factory Reset HOMI 3 moR_E

HDMI
B anweto2
3 MDR_EDID_HD
INPUT 3

=1} ANW6101

ANWE100

INPUT 4

=1} ANWE101




7.2.11 Control management

Functions

Under function, you can edit:
- TIME: the internal real time clock,
o0 . - AUTO LOCK: when this feature is enabled,

I —— you will be locked out from selecting empty
inputs that have no source connected,

S - LCD BRIGHTNESS: adjust the brightness of
Erase Memaries 7 B your LCD,

B el - KEY BRIGHTNESS: adjust the brightness of
your keyboard.

Auto Lock

Erase memories
e Into this section, you can erase individual
ot st of e e wi o e ettt settings.

This includes image, aspect, user format and keying parameters e Erase input settings memory: all input
settings will return to their default value.
This includes image, aspect, user format
FREECEERIEEEILE and keying parameters.

e Erase thumbnail: all the thumbnails you
store on your computer will be erased.

@ STRT e Erase device preset memories

e Erase local preset memories

e Erase custom formats

Functions

All preset memories on your device will return to their default value

Factory Reset

ERASE LOCALE PRESET MEMORIES

All preset memories on your computer will return to their default value

& START

ERASE THUMBNAIL S

All the thumnail: u store on your computer will be erased

ERASE CUSTOM FORMATS

All the custom Formats you store on your device will be erased

& START

ERASE LIBRARY EDID

All library unprotected EDID will be erased from your computer

& START

Factory reset
Click on start to erase all settings (except network and RCS? parameters). The unit will reboot itself after the
factory reset.

PLEASE NOTE...
When a Factory R execute arameters of the device will return to their default value
I Device needs ot after the factory reset

L Network and RCS parameters will remain unchanged

FACTORY RESET

Functions & START

Erase Memories




7.3.1 Layer management

7.3 Edit

7.3.1 Layer management

When you enter into the Edit menu, you will encounter by default this window.
On this example, we have the Screen 2 Program and the Screen 2 Preview. The following example can be
applied for any other screen configurations.

\ | il -

SCREEN 1 SCREEN 2

1920 x 1080

ANALOG WAY 1820 1080
[=1 Logos =1 Frames [52] PGM FO RN I v selected Layer B

[#] [xs00 y540 ) ] o Screen : SCREEN 2 | Preset: CURRENT | Layer: A

Source NONE ~ CLEAR COLOR

Pos/S..  Transp. Cropp... Border
Trans. Effects Timing WALL.

Reset

Layer % Freeze

®] opening s

E Closing | = >
1920 x 1080 FRAME
il

o o I

wo |l x 960 px | =
Y 540 px |
Widtk 1920 px I

I

Height  |4080%X

B
Transg |0 fa)
. (5]

MM

REsET

¥ Cropping

Siz 0

o S8 ’ = | e ) s |—
ize 0

==

TBar ONE SHOT

To display an input into one of the available layers A or B, simply drag and drop the input from the left column
to the layer on the chosen screen. You can assign or change the inputs directly on Program as well as Preview.

“ —
SCREEN 1 SCREEN 2

ANALOG WAY 19201080 1920 x 1080

[=] Logos [=_] Frames [S11PGM ¥ Selected Layer
E LOAD Screen : SCREEN 1 | Preset: NEXT | Layer:B

Source | Inputd ~ CLEaR COLOR

Pos/Size Transp. Cropping Border
Trans. Effects Timing ALL.

Reset

1
2
Layer * Freeze
3-!. - ¥ Timing
) n4 Closing I s
5
6
7
8
9

[S1] PRW ¥ Position / Size

I[=]

CLEAR v | o]
clean  CLEM pos. v F LavouTy NN i x

TAKE

Mirror TBar ONE SHOT




7.3.1 Layer management

To display a logo, open the logo list column (next to the source list) and then drag and drop the desired logo
onto the logo layer. The same procedure is used to display a Background Frame.

You can assign a source to a layer by dropping the selected source into the layer letter icon, located
on the left side of the layout window. This is particularly useful when the desired layer is hidden or
blocked by other layers.

When a layer contains an input and is not empty, the RCS? displays the input number or a customizable
thumbnail icon that represents your input. Please note: this thumbnail is not a live image.

In this example, 1 input is affected to 1 layer into the Screen 1 Program and 2 inputs are affected to 2 layers
into the Screen 1 Preview. The TAKE button on the bottom right side allows sending your configuration, made
on the Preview screen, to the Program screen.

With each press of the TAKE button, the Preview screen is transitioned to the Program screen. By default,
PRESET TOGGLE mode is disabled. That means, after a TAKE, the Preview stays as it was before. The Program

“ o
SCREEN 1 SCREEN 2

ANALOG WAY 1920 x 1080 1920 x 1080
=] Logos [=] Frames [S1] PGM ORI "Wl v Selected Layer
[~] i - | Lox0 Screen: SCREEN 1 | Preset: CURRENT | Layer:A
fce Input 3

Pos/Size Transp. Cropping Border
Trans. Effects Timing ALL.

* Freeze

.
0 s :

| s

e [GER | cory amv | MW e v uvory | B [T)

= Mirror TBar ONE SHOT

TAKING ...

and Preview will have the same content.

if desired, you can activate the PRESET TOGGLE mode from the SETUP > PRECONFIG >MISC menu, which will
automatically swaps preview and program with each TAKE. After each TAKE, the Preview is reloaded with the
previous Program.

Layers management
In this Edit mode, you have access to a lot of preset tools that can help you to create the preset you imagined.




7.3.2 Layer adjustments

7.3.2 Layer adjustments

The layer properties are found by opening the tab on the right side of the screen. Click on the double arrow
button on the right to show or hide the layer adjustment tab.

“ o
SCREEN 1
ANALOG WAY 1920% 1080
[=] Logos [=] Frames [S1] PGM jo ¥ Selected Layer
Screen: SCREEN 1 | Preset: CURRENT | Layer:A
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|
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3
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SN ) e e

TBar ONE SHOT

ize V Iu

Selected layer
The selected layer status information will indicate which screen, layer and source assigned to that layer are
selected. You must select a layer in order to see the layer properties menu for that layer.

Reset feature

You can reset each category of layer settings quickly (Pos/Size, Transparency, Cropping, Border, Transitions,
Effects, Timing) or you can choose to reset every settings in one click using the ALL button. You can freeze the
input assigned to the selected layer using the Freeze button.

The settings reset here only affects the selected layer on the selected preset. For example, you can reset the
layer settings for layer A on Preview, and Program will be unaffected until you press TAKE.

Position/Size

Adjust the size horizontally (X) or vertically (Y), then adjust the width and the height of your layer. You can
use the cursor or directly enter a value. To keep the aspect ratio by using the cursor, please enable the KEEP
ASPECT RATIO button. You will find it on the right of the width and height cursors.

Transparency
Use the Transparency to give at your layer a transparent effect. Layers behind the transparency layer will
show through more or less based on the transparency value.

Cropping (only for live layers)

The Cropping feature allows you to cut the part of the image you don’t want. Simply adjust the size horizontally
or vertically and then adjust the position to display only the desired content. This crop is a layer property, all
inputs displayed in this layer will be cropped. Do not confuse this setting with the input crop which is specific
to aninput.

uﬂ



7.3.3 Effects

Borders (only for live layers)
Choose a border for this layer from the available patterns including EDGE and SHADOW. For each pattern you
will have specific values to adjust like colors, transparency, width/height or position V and position H.

¥ Border

_I_I-

#013888

_II_I_E

Transitions

On the Transitions section, you can filter which transitions you want to see. For Example, you can show just
the Slide, Wipe, Circle or Stretch transitions.

Each layer has an opening and a closing transition. The opening effect will be applied when the layer switch
from a source to another source or when the layer is switching from empty and appears with a source.

To set up the duration of the transition, please see below the timing and duration settings. If you want to
force the layer to perform a closing and opening transition, see FORCE TRANSITION.

7.3.3 Effects

Force transition

The Force Transition button disables the cross-transition between | ¥ Effects B
two sources into the same layers. Enabling the Force Transition,
it forces the layer to go out and then go in with the desired effect
instead of mixing directly the two sources.

Smooth Move
Enable the Smooth Move to perform a smooth transition on the layer. Disable the smooth move if you require
a constant speed move.

H&YV Flip (only for live layers)
The H&V Flip rotates the PIP on a horizontal or vertical axe. All image data will be flipped.

7.3.4 Background frame

The Background frame layer acts like any other layer. Simply select it and drag and drop a saved frame.
The frame 1 is now assigned to the Background frame into the Preview preset.

| e

E-8




7.3.4 Background frame

Layer layout

CLEAR - ] " r— -
CLEAR T POS. ¥ SZE ¥ :'.o( x LAYOUT ¥ a  ~ | i o D t)

The layer layout gives you access to several predefined layouts with 2 or 1 PIP already sized and placed into
the output. It can help you to quickly set up 3 PIPs side by side for example. (Number of layers depends on
the used mode.)

« |1 Once clicking on the layout button, you have access to the presets with
. = 2, 1 PIPs or all layouts.

Ec_ : ﬂi E ! [ E Two other options are available below:

R— - Clear other layers: layers already displayed and not included into the
Clear Other Layers chosen layout will be cleared
RO e oy - Fade out other layers: layers already displayed and not included into
the chosen layout will be faded out during the transition. They are still
present on the preset but with a 100% transparency.

Layout

After selecting the layout, the changes are applied on the selected screen. The size and position of all layers
are updated. After applying a layout template, you can make further modifications to the layers before Taking
your selections to Program.

Layer position

A layer position shortcut is also available. After having selected a layer, simply click on the
Pos. button to have quickly access to a layer position. Choose the new position. The change
is applied straight away on your preset.

Layer size

Size x

You can choose between several aspect ratio. Once selected, the new aspect ratio is applied
on the selected layer.

Other layer adjustments:

- CLEAR BUTTON: this button allows you to clear the selected layer from your preset,
- CLEAR ALL BUTTON: remove all layers from your preset,
- CONTENT SIZE: set layer size to its content size,
:l i - SCREEN SIZE: set layer size to screen size,
- LAYER SIZE/SOURCE RATIO: set the layer size to fit the source ratio,

Rl - ALIGN BUTTON: you need first to select at less 2 layers, then you can align them horizontally or
vertically (use Shift to select 2 layers),




7.3.5 Preset load and save management

- KEEP ASPECT RATIO BUTTON: enabling this feature will keep the layer aspect ratio during resizing,
. - WIREFRAME MODE: allows to enable/disable the layer thumbnails on your RCS?,

. - SHOW LAYER OUT OF SCREEN: enable/disable the possibility to display a layer out of the screen
into the RCS?,

. - TRAP LAYERS ON SCREEN: disable the ability to position the layer off of the screen,
u - HIDE UNUSED LAYERS: empty layers will not be displayed in the RCS?,
-TOGGLE PRESET: enable/disable the TOGGLE PRESET (the Preview becomes the previous Program),
- RELOAD PROGRAM: load the preset of the Program screen into the Preview screen,

- STEP BACK: return to the configuration you had before the last TAKE,
—

Mirror x

Frame LayerA LayerB Logo 1

_ - MIRROR BUTTON: the mirror button allows you to define for
each layer, logo and frame, the way it will be copied in the

preset. You can choose to mirror the layer, flip the position,
or flip the position and the data from another screen. To
access this feature, you first need to be in the Matrix mode.

If you activate one mirror function, Screen 2 will automatically follow Screen 1
when switching from Program to Preview.

7.3.5 Preset load and save management

Save a preset
Once your preset is set up, you can store it into one of the 64 preset slots. To do that, click on SAVE
il MM and choose the number corresponding to the slot number.

SAVE

[$1] PGM : Save To MMemory(shift-click to edit details) * X x

WARNING: in the RCS?, you cannot save a preset for only 1 screen when you
are in matrix mode, only MASTER MEMORIES can be saved into the EDIT
section.

In addition, in the EDIT section, as you work on screen by screen, the load
button loads only single memory. You will find the load MASTER MEMORIES
in LIVE MODE.

The first 8 presets are stored into the unit, all the other presets are stored
locally on your computer, and will only be available when using the RCS2
software.

If you want to have more details, you can SHIFT+CLICK on any preset to
bring up a detailed status window. In this window, you can rename each preset using the PRESET LABEL.

E * = Edit MM1 x
- The first icon displays a window with all preset detail,
- The second one allows you to let the windows open,
- The last one quits the window.




7.4 Live

Load a preset TR — Y
To recall a previously saved preset, click the Load button (on the right Ao scale
side of each screen) and select a preset to load. o2

Reset button

You can reset a screen using the reset button. Using that, all sizes
and positions will be deleted. Your layers will be reset. If the «HIDE
UNUSED LAYERS» button is enabled and all of your layers are empty
and hidden, you can still access the layers using the layer icons on the
left side of each screen.

7.4 Live

The Live mode is designed for easy live operation of the device after you have created some presets.
@ SCREEN 1 SCREEN 2
ANALOG WAY 1920 x 1080 1920 x 1080

[=] Frames [S1] PGM (M1.1) [S2] PGM (M1.2) Auto scale

[ oo || [ e R
| :

STEP
é BACK

QUICK FRAME ]

Reset PGM
Reset PRW

LOAD

-»4

® 0090000

M

MM4 - - MM6 - - MM - MM2 - MM3

Scene 4 Scene 6 Scene 8 Scene 10 Scene 11

On the right, you will find all your saved presets under the tab called “MASTER MEMORIES”.
A simple drag and drop on the screen will load your preset into the screen (Program or
Preview).

If you want to change an input into your preset into the live mode, simply use the left source
ribbon and drag and drop your input into a layer.

You can still use the load master memory to load a master memory from the memory of the device or the
RCS? using the following windows.

Please click on SAVE MASTER MEMORIES and then choose a number to save the current preset of the unit
into a master memory.

4



7.4 Live

You can load at any moment a frame or a logo in the same way into a frame or logo layer.
To activate the QUICK FRAME, simply press the Quick Frame button (located on the right side of each screen).

Remember that a preset saved into a screen with a 1024x768 resolution, will keep its size into a screen of
higher resolution. Therefore, it is best to save preset memories only after you have configured the output
resolution.

You still have access to the LOAD/SAVE/RESET preset feature.

Once your preset is ready to send, use the T-bar, or the TAKE button.

You still have access to STEP BACK button.

When you use several screens, you have the possibility to load a preset on one or several screens. To TAKE
only one screen separately, select which screens should be affected by the TAKE using this button:

SEQUENCE:

The sequence feature consists on a timeline composed by 16 scenes. Each scene can be filled by a preset
memory. Simply click on MM to choose the memory slot you want to put into the scene.

To select the memory, simply choose it into the list or drag and drop it into the scene box from the memories
selection (on the right).

This toolbar acts like a command for your timeline.

® 0090000

Simply click on play to launch the timeline.

You can stop the timeline at any moment using the pause or stop button.

Use the loop button to load again your timeline when it’s finished.

Take a look at the global time of your timeline thanks to the clock on the right of the toolbar.

Note: To control the SmartMatriX?, Analog Way also provides Crestron and AMX modules. For more details,
see appendices.




8.1.1 Menu navigation

—O 8. OPERATING THROUGH THE FRONT PANEL

8.1 Front panel

8.1.1 Menu navigation

To access the SmartMatriX? menu, press the EXIT/MENU button in the
[W]ANALOG WAY® : control section. To highlight items in the menu which will appear on the
: VED screen, turn the scroll knob left or right to the desired menu item.

When you have reached the desired menu item, press the ENTER button
in the control section to access that menu function. Pressing the ENTER

pulige==l8 button when a selection has been made sets the value to that selection
in the SmartMatriX> memory. When all settings have been made, press
the EXIT/MENU button to exit sub-menus and return to the main menu.

= SmartMatriX?

Simply selecting a menu item will not set it to that value. Be sure to press the ENTER button when
configuring the menu items or to push the scroll knob.

8.1.2 Home menu

Pressing the MENU button in the menu section of the SmartMatriX?, will display and give you access to the

following items on the menu VFD screen:

- OUTPUT 1 PROG 1: select to set the output types and resolutions of Output #1,

- OUTPUT 2 PROG 2: select to set the output types and resolutions of Output #2,

- VIDEO OUT: select to configure Video output card settings,

- INPUTS: select to configure the 10 individual input types and resolutions,

- PRESET: select to store and use presets,

- IMAGE*: select to change source image settings of an input,

- KEYING/TITLING*: select to access keying and titling controls and parameters when video layer is selected,

- SCREEN: setup your background color and your Quick Frame,

- LAYER*: select to adjust layer size, position, border, transparency or transitions,

- FRAME/LOGO: select to store (record), use and manage logos and frames into the SmartMatriX?,

- AUDIO: select to access all audio input and output parameters,

- CONTROL: select to access device software information, LAN settings, reset factory settings, and other user
oriented functions.

* These items are only displayed if a valid input is assigned to the current layer.

8.1.3 Operating modes

The SmartMatriX? offers 1 mode to work from: the Matrix mode which turns your SmartMatriX? into a true
10 x 2 scaled matrix with numerous effects and PIPs and logos.




8.1.4 Reseting default values

8.1.4 Reseting default values

It is strongly recommended resetting all of the default values of your SmartMatriX2 unit before setting up your
shows and events. This will help eliminate confusion caused by unneeded settings from a previous operator.
To do so, press the EXIT/MENU button and select Control in the menu by rotating the corresponding knob.
Then press the ENTER button to enter the Reset/Erase sub-menu. Select Default Values by rotating the scroll
knob, and press the ENTER button to enter your choice to restart your SmartMatriX? with its factory settings.
This operation should take approximately 30 seconds.

8.1.5 SmartMatriX? color codes

Analog Way engineers have developed a handy, user friendly way of identifying machine status on the front
panel, via the use of color codes on the buttons of the machine. All new Analog Way machines use the same
codes, for quick recognition of the status of any device of the range, at any given time.

For the SmartMatriX?, button color codes are as follow:

e Sources on the Program output are indicated in red when active,

e Sources on the Preview output are indicated in green when active,

e Buttons in the layer section turn red or green, depending on whether the selected layer is active in
respectively the Program or Preview window,

* menu buttons are indicated in green,

¢ Selecting a button with an available source or function will cause that button to blink green on the preview,
or red once it is on the Program output,

e TAKE button reacts as follows:
- If take function is available, the button will appear in green.
- When the take function is active, it will light up red.

#1 = Source is on the Program output

Solid red:
@ #2 = Freeze enable
#1 = Source is on Preview
Solid green: @ #2 = Function available for modification
#3 = Current output on Matrix mode
o Layer/source selected or is currently active
Blinking red: on the Program output

Layer/source selected or is not currently
active on the Program output

2

Blinking green:

8.2 Settings in Matrix mode

8.2.1 Source Input selection

Plug your sources using the 4 multi-plug inputs, 2 HDMI®Inputs or 4 3G/HD/SD-SDI inputs.
Be sure that all connectors are firmly attached using all available locking screws.

8.2.2 Input selection settings

To set up your inputs automatically: Inputs menu > Auto settings
You can also do it manually on each input# using the ENTER and the Knob button and set up the inputs type
one by one.

You can also check your actual input configuration using the config status: Inputs menu > Config Status

h



8.2.2 Input selection settings

You can find several settings for each input (some settings are specific to some signal type):
- INPUT STATUS: display the input status,

- AUTOSET INPUT: launch an automatic setup on the inputs,

- FREEZE: freeze the input,

- ACTIVE PLUG: choose the active plug of the input,

- TYPE: to set up your input type (Computer, Video etc..),

- AUTOSET: launch an autoset on this plug,

- ENABLE: enable/disable the input#,

-SYNCHRONIZED: enable this option when you source is from the same refresh rate than the reference rate,
- HDCP ENABLE: enable/disable the HDCP automatic detection,

- HSYNC LOAD: to change the load of the sync signal,

-3D COMBO FILTER: choose manually the combo filter for interlaced source,

- FORMAT: for analog source, choose to force a analog format,

- AUDIO INPUT: select the input audio source according to the input video source,

- EDID: set up your EDID for the selected plug,

- STATUS: to summarize the input status.

Concerning the HDMI®inputs, a specific feature allows enable/disable the HDCP receiver for the input chosen.
It can be very useful especially using a Mac: Input menu > HDMI®# > HDCP detection

NOTE: The input status is available at any time in the status input menu and can give you information about
format rate and HDCP status.

8.2.3 Source Output selection

Once your inputs all have been configured, the output settings of the SmartMatriX? must be set according
to the machines plugged on your SmartMatriX? Program and Preview outputs (video projector, Preview
monitor...).

NOTE: If you want to use HDCP content from your sources, be sure to attach HDCP compliant screens or
projectors. If HDCP sources are used with non-HDCP compliant screens, the output image could be
disabled.

8.2.4 Output selection settings

To set up the output, go in the Program Output #1 or Program Output #2 menu and choose first the adapted
format/resolution, and then the appropriate rate for your screens by using the knob button and the ENTER
button.

Program Output > Output Format > Output rate

Please note that a pair format/rate is only applied when the rate is validated.

Use the native resolution of your screens/projectors in order to obtain the best image quality. In the Program
Output #2 menu, you can also match the output configuration the Program Output #1 to the Program Output
#2 by checking the case Sync w/Out 1. It allows you to set up your outputs via the output 1 menu.

Program output #2 > Synch w/Out 1

Some other settings are available too:

- OUTPUT STATUS: display the status of the selected output,

- OUTPUT FORMAT: choose the output format,

- OUTPUT RATE: choose the output rate,

- GAMMA: use this feature to set up the output gamma,

- ANALOG TYPE: set up the type of synchronization of your analog output,
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8.2.4 Output selection settings

- HDMI TYPE: set up the type of color space of your digital output,

- DVI as HDMI: DVI output content as HDMI. Audio is included,

- HDCP DETECT: enable or not the HDCP detection on the output,

- CENTERING PIC: display the centering test pattern,

- TEST PATTERN: choose to display one of the available test pattern.

All changes have to be validated by pressing the ENTER button in order to be saved

NOTE: The output status can provide you all information about the output in real time. This feature is
particularly needed when HDCP is used with long cable to be sure that the communication is well
handled.

Video Out

The Video Out allows you the same settings as other outputs with some additional specific options:
- SHARPNESS: set up the sharpness on the video out image,

- FLICKER FILTER: apply a flicker filter on your video output to eliminate flickering,

- UNDER/OVERSCAN: enable or not the automatic video zoom overscan,

- ADJUST: adjust your video output in term of H/V position and size.

In native Matrix mode, the menu “Connection Mode” allows you to choose recording Output #1 or Out-
put #2.

Display mode Presentation

Output #1

Menu > Video Out > Connection > Screen #1

Output #2

Menu > Video Out > Connection > Screen #2

Output #1 & #2 side by side

Menu > Video Out > Connection > Screen H-Titled

Output #1 & #2 Top and Bottom

Menu > Video Out > Connection > Screen V-Titled

In Matrix mode, the SDI output embeds audio from Output #1 and Output #2.

8.2.5 Working with layers

To work with native Matrix mode, you have to use the Matrix # buttons first.
For instance, if you want to put the frame #1 on the Output #1 and the live source #3 on the output #2:

h



8.2.5 Working with layers

Press Matrix #1 button > Press Frame button > Press input #1
Press Matrix #2 button > Press Layer A button > Press input #3
Press TAKE to view the result on both screens

Don’t forget to press the correct Matrix # button before pressing the Layer selection button, in order to be
sure doing the manipulation on the correct output.

2 layers 2 layers + Frame 2 layers + Logo

8.2.6 Working with layers functions

Once a source is assigned to a layer, you will have access to some layer settings in the Layer menu or direct-
ly by pressing the layer button.

The settings available depend on the layer selected:

- Layer copy mode: select the copy and adjustment

- Layer adjusts: set up layer size and position,

- Layer zoom: set up layer zoom size and position,

- Size Templates: adjust a specific size (Fullscreen, 1/2, 1/3, ...),
- Transparency: adjust the layer transparency,

- Border: choose the border and adjust its properties,

- Force Transition: enable/disable the selected transitions

- Opening and Closing effect: adjust the Open/Close effect type and duration,
- Smooth move: enable/disable smooth move,

- H&YV Flip: flip the data of the layer,

- Status: get the selected layer status.

All changes have to be validated by pressing the ENTER button in order to be saved
Press TAKE to view the result on the Program screen.

Settings available:

Settings Background live / PIP#1 PIP#2
Position YES YES
Size YES YES
Zoom YES YES
Transparency YES YES
Border YES YES
Opening effects YES YES
Closing effects YES YES
Smooth Move YES YES
H Flip / V Flip YES YES

‘ﬂ



8.2.6 Working with layers functions

Even the logo and frame buttons can access to their own settings, but a logo/frame# has to be affected too.
The Program output can displayed simultaneously up to 5 layers stacked from bottom to top as follows:

- Frame: one stored frame selected from 8 available,

- Layer A: one source selected from 10 inputs available,
- Layer B: one source selected from 10 inputs available,
- Logo 1: one stored logo selected from 8 available,

- Quick Frame: one of the 8 frames available.

8.2.7 Opening transitions and closing live layers

When transitioning live layers, depending on how many scalers are in use, the SmartMatriX? TAKE function
will actin one of 3 different ways when transitioning the next preset (Preview) to the current preset (Program):

e TAKE 1 - shot: Case #1

- There are enough scalers for making a transition

- All inputs are locked on to scalers

- There are no contraints for closing before the TAKE

- All opening and closing transitions can be performed simultaneously.

e TAKE 2 - shot: Case #2

- There are enough scalers for making a transition

- All inputs are locked on to scalers before the TAKE

- There are no constraints for closing during the TAKE

- All the necessary closing transitions are performed to free occupied scalers and then the SmartMatriX?
performs all openings (for example, when a frame or a logo needs to be changed, except with Cut effect).

e TAKE sequenced - shot: Case #3

- There are not enough scalers for making a transition

- All inputs are not locked on to scalers

- All the necessary closing transitions are performed to free occupied scalers. The SmartMatriX? locks on to
new sources and performs all openings.

8.2.8 Layer adjustment menu

¢ To have access to the layer adjustment menu, a source has to be affected to your layer:
Press Layer# button > Press source #

e Once a source is attached to layer, you can have access to the layer adjustment menu:
Press Layer# button
Press TAKE to view the result on the Program screen

e To adjust layers, there is a shortcut on a front panel too:
Press Layer# button > Press ADJ button

8.2.9 Layers with transitions & borders
All the transitions (Cut, Fade or Transitions) are available in the native Matrix mode. You will be able to per-

form powerful transition effects seamlessly. It can depend on your configuration.

The SmartMatriX? has 4 scalers, to understand how your effect will be performed, you need to know how
many scalers are used on your outputs. Don’t forget that you always need one free scaler to perform seamless
transitions.

Example:
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8.2.9 Layers with transitions & borders

1 layer on each output > 2 scalers used > 2 seamless transitions
2 layers on each output > 4 scalers used > no seamless transition (ie: fade through black)

The frame and the logos are not considered as live layers and are not counted as using a scaler.
Transitions

All the settings are available in the Layer menu after pressing the selected layer.

To use it: Press the selected Layer # > Select the transition effect into the layer memory

The effect will be immediately attached to the selected layer (Preview).

- CUT: duration time can be set to delay the cut effect,

- FADE:

e Adjustable pre-timed fades or manual transition with T-Bar,

¢ Fade between any input, computer or video,
e Adjustable cross-fading duration,

Program —»ﬂ—» Program

Preview Preview
- WIPE:
e Numerous wipes can be selected horizontal and vertical, from the center or outside, in circle, Zoom in and
out,

e Horizontal: from left, center -or- vertical: from up, down, center,

- SLIDE:

e Sliding of video or computer images during the transition,

¢ Horizontal: from/to left, right -or- vertical: from/to up, down.

The SmartMatriX? offers 33 seamless transition effects including 31 options, in addition to a dissolve (fade)
and a cut effect.
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8.2.9 Layers with transitions & borders
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8.2.10 Capturing frames

- BORDER:

The border has to be setting up in the Layer Menu:

Press Layer# button > go in border menu > select and set your border with color and size
Press TAKE to view the result on the Program screen.

NO BORDER EDGE BORDER

»-

e A transparency can be applied
to the shadow border

e Size and style of layer border are
adjustable

8.2.10 Capturing frames

It is possible to store up to 8 frames in the SmartMatriX? non volatile memory. To capture a frame, display the
exact content you want to save on one of your outputs, at the exact resolution, you can use the freeze button
if you want. Then follow this step:

Logos/Frames menu > record Frame menu > Frame #

Choose the frame number slot and wait until the unit finishes to save. Your frame is now saved and you can
use it through the frame button.

The capture of frames can be done only under the following conditions:

- The capture can be done from the Program output #1 or the Program output #2,

- The disappearance of frames or logos on the Program output is normal during saving.

A frame captures the state of the specified output at the output resolution, and must be recalled using the
same output resolution. Resizing or other image manipulation of the captured frame is not possible.
Attempting to use a frame at a different resolution will result in a partial frame display or a frame which does
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8.2.11 Working with frames

not fill the screen. During the capture, the output is outlined by a white border and includes the pixels into
the white rectangle.

8.2.11 Working with frames

Frames are mainly used as backgrounds in a typical show or event setup, and can be recorded from any of
the SmartMatriX? 10 sources and called back at the press of a single button. To use a frame, be sure first that
it is well saved, then:

Press Frame button > Press Frame # button

NOTE: Frames may be used only one at a time and can be placed only in the frame layer.

8.2.12 Opening transitions & closing still layers (logos or frames)

When transitioning still layers, depending on how many scalers are in use, the SmartMatriX? TAKE function
will act in one of 2 different ways when transitioning the next preset (Preview) to the current preset (Pro-
gram):

- TAKE shot: 1

e All still frames make an opening and closing phase.

¢ All sources of the same layer are completely different between the current preset and the next preset. The
opening and closing effects of the layer are set to Cut.

- TAKE shot: 2

* One of the layer makes a change of source which is not in Cut.

¢ The opening and closing phases can be done with different effects.

¢ The still frame appears and disappears of the layer with the following effects: Cut, Fade, Slide or Wipe.

8.2.13 Frame input setup menu

In the frame input setup menu, you have the possibility to save a frame, and the possibility to erase a stored
frame:

Logos/Frames menu > save Frame > Frame #

Logos/Frames menu > Erase > Frame #

8.2.14 Frames as layer
The frame is considered as a layer and has some settings available: Pos./Size, Transparency, Opening/Closing
effect, Smooth move and Status.

Those settings have to be used as layer settings. Press frame button to have access to the layer menu settings.

You can change frame or delete frame on the Preview screen using the same way the layers do:
- Delete: Press frame button > Press Black

- Change: Press frame button > Press another Frame #

Press TAKE to view the result on the Program screen.

8.2.15 Layer transitions & effects
The SmartMatriX? offers a wide variety of transitions between the scenes you create for your shows and

events. It allows for live recall of 8 user presets, each of which you can edit at any given time.

1. Whether catering for complex event setups, or putting together intricate shows, your SmartMatriX? will
also deliver some of what you could expect from a dedicated mixer, along with its switcher and scaler
capabilities.
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8.2.15 Layer transitions & effects

2. In the Layer Selection section, press the Layer A button. The button will start blinking. The parameters of
the layer will automatically appear on your SmartMatriX? VFD menu screen.

3. In the Layer Menu, make the position, size, border and transparency settings you like, then select Opening
Effect in the layer options, press the ENTER button and select Type. Select Slide Left - Right for example,
and press the ENTER button to confirm. Navigate to Duration in the Opening Effect sub-menu, and set the
duration of your effect by rotating the SCROLL knob and pressing ENTER.

Repeat the procedure in the Closing Effect sub-menu to determine the way your layer will close. Try Slide
From Left - Right for the closing type with a duration of 1.5 seconds for example.

8.2.16 Capturing logos

To capture a logo, display the exact content you want to save on the Program, you can use the freeze button
if you want. Then follow these steps:
Logos/Frames menu > Record Logo menu > Set up your logo > Store menu > logo#

To set up your logo you have several features available:
- Position / Size Adjustment

- Keying type

- Luma / Chroma key

- Cut out color.

Select the logo number you want to save and wait until the unit finishes saving. Your logo is now saved and
you can use it through the logo button.

You can save up to 8 logos with the SmartMatriX>.

The capture of logos can be done only with the following conditions:
- The capture can be done on the Program output #1 or the Program output #2
- The disappearance of logos on the Preview and Program output is normal during saving.

The logos are captured with the same size as is visible on the Program output without any form of adjust-
ments. If zooming is required, resize the layer or use the layer zoom or input zoom.

A logo captures the state of the defined area on the specified output at the Program output resolution, and
must be recalled using the same output resolution. Resizing or other image manipulation of the captured
logo is not possible.

The capture zone is outlined by a white rectangle and includes the pixels beneath the white border. The non-
captured area has a reduced brightness.

Logo capture is limited in the number of pixels being captured. When the logo capture area is resized, exten-
ding the horizontal size may reduce the vertical size to compensate.

Logos can also be captured and displayed with transparent areas. By adjusting the keyer in the logo capture
menu, the portions of the captured area can be keyed away and captured as transparent.

The logo “Cut out color” can help display which portions of the image will be captured as tranparent.
NOTES:

e The cut out color is only a visual tool to help identify the transparent areas of the logo. These colored re-
gions will not be captured but later displayed as transparent area.
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8.2.17 Capturing an animated logo

e Capturing a “logo” is limited to a small percentage of the output resolution. To capture and display a full
screen image, use the still “frame”.

8.2.17 Capturing an animated logo

To capture animated logo, display the exact content you want to save on the Program screen, you can use the
freeze button. Then follow this step:
Logos/Frames menu > Record Anim menu > Set up your Anim > Store menu > logo#

To set up your animation, you have several features available:

- Position / Size Adjustment

- Keying type

- Luma / Chroma key

- Recording time

- Cut out color

Select the animated logo #8 and wait until the unit finishes saving. Your animation is now saved and you can
use it through the background logo button.

Only one animated logo can be saved in the SmartMatriX2.

8.2.18 Logos input setup menu

In the logos/frames menu, the logos can be deleted in the Erase menu:
Logos/Frames menu > Erase menu > Select Logo#

8.2.19 Working with logos

A simple or animated logo can be manipulated through the front panel. On the front panel, the logo# are
associated to the input# respectively. To assign a logo# to the logo layer:
Press Logo1l Layer button > Press Input#

Logos #1 to #8 are available directly by the input # button on the front panel.

You can change logos or delete logos on the Preview screen using the same way the layers do:
- Clear: Press Logo (#1) button > Press Black
- Change: Press Logo (#1) button > Press another Input#

8.2.20 Logos as layer

Logos are under the layer rules, you will have direct access to settings by pressing the logo layer button. You
have 1 logo layer button available.
You can use the Pos/Size/Zoom adjustment button and the Effect button from the front panel too.

8.2.21 Creating presets

The SmartMatriX? allows the creation of user defined presets very easily. Any setup you have configured on

screen, can be stored into one of the 8 available user presets.

1. After having configured layers, transitions, logos... on your screen, go to the Preset menu by pressing the
EXIT/MENU button, and select Preset by rotating the scroll knob. Then, press the ENTER button to enter
the Preset sub-menu. Choose Preset Copy by scrolling with the corresponding knob, and press the ENTER
button to access the sub-menu.

2. In the sub-menu, choose both screens or only Screen 1 or Screen 2 to determine which screen you want to
memorize the preset from, then set the preset memory (#1 to #8) you wish to use as your “User Preset”
(by default, the SmartMatriX? will choose the next available preset in the SmartMatriX? memory).
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8.2.21 Creating presets

By pressing the ENTER button, the SmartMatriX? will ask you to confirm. Select Yes, your screen is memorized
as a preset.

8.2.22 Working with presets

In Matrix mode, you will find a new menu into Preset menu called “Preset management”. This will help you
to define what kind of preset you want to save:

- BOTH OUTPUT: preset saved for both outputs,

- CURRENT OUTPUT: preset saved only for the current output,

- OUTPUT 1: preset saved only for output #1,

- OUTPUT 2: preset saved only for output #2.

The 8 user presets of the SmartMatriX? can be recalled at any stage during your show or event.

1. Press the PRESET button, then press one of the eight first preset buttons to choose which memory (#1 to
#8) you wish to use.

2. Once you have selected your preset, simply press the TAKE button to view the result on your main screen.

8.2.23 Working with audio

Into the audio menu, you will find some audio adjustments:

¢ Audio mode:
- NO AUDIO: the audio of your device is switched off
- PRESET MODE: the standard mode of use of the device

You have two possibilities:

= Top layer: the sound on the output will follow the audio input of the top layer.

* Breakaway: when breakaway is activated, the audio on the output is memorized into the preset. A change
of preset, changes the audio on the output. A change of content into a video layer has no effect on the
audio.

- ROUTING MODE: in this configuration, simply choose an audio input to assign it to the output. The audio
configuration remains the same during the show.

e Source settings: into this menu you will have access to all source settings:
- ANALOG SETTINGS:

* Mute: select to mute the input

= Stereo: select to choose between mono or stereo input

* Analog gain: set up the analog gain of your analog input (0 for 4dBu)

= Level/balance: select to adjust the input audio level and right and left balance.
- DIGITAL AUDIO:

= SPDIF/AES3: choose the digital audio output mode

¢ Main audio/prelist audio: define the main or prelist audio settings:
- PRESET MODE:

= Top layer: the sound on the output will follow the audio input of the top layer.

* Breakaway: when breakaway is activated, the audio on the output is memorized into the preset. A change
of preset, changes the audio on the output. A change of content into a video layer has no effect on the
audio.

* Master mute: select to mute your master audio

= Stereo: select to choose between mono or stereo output

= Analog level: set up the analog gain of your analog output (4dBu by default)

* Master volume: set your master volume of the output

= Balance: set the right/left balance of your output.
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8.2.24 Working with Mirror modes

8.2.24 Working with Mirror modes

The Mirror Matrix mode is a specific Matrix mode where the output #2 will be the perfect mirror copy of the
output #1. In that way, each settings apply to output #1 will be performed on the output #2 too.

Mode Menu > Matrix mode Menu

Using the Matrix mode, several configurations are available, the simple mode and the mirror mode.

Using the Mirror mode: to use the mirror mode, simply select the Matrix mode throught the main menu,
then the mirror mode can be activated layer by layer thanks to the layers menu. Select the chosen layer and

go in the layer menu, then select the “Layer Copy Mode” menu. There are several mirror positioning options:

1. No Copy: this mode is the standard Matrix mode, output #1 and #2 are independent.

OUTPUT #1 OUTPUT #2

2. Clone mode: Outputs #1 and #2 will be the same. All changes on output #1 will be affected to output #2.
Layers will have the same position and size.

OUTPUT #1 OUTPUT #2 OUTPUT #1 OUTPUT #2

3. Copy & H.pos Flip mode: Output #2 will be exactly the same as output #1 except the fact that the selected
layer will have its H position flipped (standard Mirror mode).

OUTPUT #1 OUTPUT #2 OUTPUT #1 OUTPUT #2

4. Copy & H.Flip all modes: Output #2 will be exactly the same as the output #1 except the fact that the selec-
ted layer will have its H position and data flipped (only for live layers).

OUTPUT #1 OUTPUT #2 OUTPUT #1 OUTPUT #2
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8.2.25 Special features

NOTES:

e Remember to simplify the use of this feature, you need to manipulate Output #1. While in mirror mode,
Output #2 will follow.

e Every change on Output #2 will have an effect only on Output #2, but remember that if a change occurs on
Output #1 after that, Output #2 will update automatically to match output 1.

8.2.25 Special features
- DYNAMIC FIT (automatically activates the transparent background)

e Automatic adjustment of the layer (Ratio) to fit the source image borders during a transition.

Image live




8.2.25 Special features

-SMOOTH MOVE EFFECT
e Smooth Move layer control the acceleration of the layer. The time
can be different between the opening and closing layer,

- WORKING WITH DSK (Chroma / Luma key)

e SmartMatriX? allows to use a live source with green or blue (or
any color) background and to key it over another live input,

e Background is removed and replaced by another source,

* Title can be keyed (DSK) on Analog or Digital Sources.

To use keying, first select a source in the desired layer:

Layer button > source number button

Then in the main menu, select the Keying/Titling menu.

You now have several choices to key your sources. The Luma Key and the Chroma Key based on the Luma
pixel values and the Chroma pixel values and for both an additional Titling menu which can be useful to
choose the transparency value of your keying.

Keying/Titling menu > Type menu > Select your keying type

Once your keying mode is selected, the SmartMatriX? provides you some keying advance setting:
For Luma Key:

e Luma Keying is used to key from a particular luminous intensity. It produces a hard edged key based on
intensity, which is most suitable for titling effects. You can choose to key things that are extremely dark or
extremely bright and keep everything in between, or invert to key only things that are of a medium intensity.

¢ The black and white levels define where to begin the keying. Inthe range 0 to 255, O represents no luminance,
or black and 255 represents full luminance, or white.
- Level Black: As the Black Level is changed from 0 to 255, things that are black are first keyed out, followed
by dark grey, then light grey, and so forth, until the entire picture is keyed out at 255.
- Level White: As the White Level is changed from 255 to 0, things that are white are first keyed out,
followed by light grey, then dark grey, and so forth, until the entire picture is keyed out at 0.

Non-Inverted mode

Keyed Away Visible Picture Keyed Away

Black level White level
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8.2.25 Special features

For Chroma Key:

Chroma Keying is used to key from a particular color. It produces a key which is most suitable for moving
images and “weatherman” style applications.

- Color grabber:
Select Chroma Key menu > Select Color grabber menu

Using a crosshair, you can select a particular hue based on what is on screen. Once you have adjusted the
crosshairs to a desired position, press set/enter to capture the color value at that instant. You can then adjust
the other parameters such as Tolerance to further refine your key.

- Manual Setting:
Select Chroma Key menu > Manual Settings menu

¢ R,G,B: these controls allow you to manually select a hue, defined by its Red, Green, and Blue values as you
can find in Windows (Paint software).

* Tolerance: the Tolerance parameter allows you to expand your key color selection to include colors which
are similar to the selected value. A tolerance of 1 will select only the desired hue, whereas a tolerance of
255 will select nearly all hues.

e Black Level: this option permits adjustment of the luminance levels of the keyed hue. The Black Level is the
luminance lower bound. Colors in the selected hue range with a luminance brighter than the Black Level but
darker than the White Level will be considered part of the key.

e White Level: this option permits adjustment of the luminance levels of the keyed hue. The White Level is
the luminance lower bound. Colors in the selected hue range with a luminance brighter than the Black Level
but darker than the White Level will be considered part of the key.

¢ Titling alpha: if you have selected one of the two Titling mode, the titling menu appears. This option places
a transparent black backdrop behind the entire layer to which the key is applied. This effect is useful for
using bright titles on bright backgrounds, such as clouds.

¢ Invert keying: by default, this mode is disabled. When this mode is activated, the key selection will remain
on screen, and all other portions of the image will be keyed away. For example, you would see the green
screen behind the actor, while the actor would be keyed away.




8.3 Menu tree

MATRIX MODE

OUTPUT #1

FORMAT:1920X1080
RATE: 50.00HZ
LOCK: INTERNAL
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Layerl|Inputl |SDI4
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8.4 Menu tree

The following menu tree provides the sections of the MIDRA’s menus.
Please note that the availability of the sections depends of the reference and the configuration of your

device.

MENU

MATRIX

SYNC W.OUT1

OUTPUT STATUS

OUTPUT FORMAT

OUTPUT RATE

GAMMA

FLICKER FILTER

ANALOG TYPE

DVI TYPE

DVI AS HDMI

HDMI DETECTION

CENTERING PIC

TEST PATTERN

T

CONFIG MODE

CONNECTION

OUTPUT STATUS

OUTPUT FORMAT

OUTPUT RATE

BACKGRND COLOR

ADJUST

FLICKER FILTER

UNDER OVERSCAN

CENTERING PIC
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g CO'FIG MODE
g CONNECTION
L OUTPUT STATUS |
AR
| GBS |
gC/CHGRND COLOR
m DU
S
QL FUCKERFILTER |
| SELIES
U VDER OVERSCAN
g CENTERING PIC_
g TEST PATTERN |

TEST PATTERN

—
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8.4 Menu tree

MENU

we]

—

CONFIG STATUS PRESET MNGT AUTO CENTERING
AUTOSET ALL PRESET LAYOUTS BLANKING ADJUST
SYNC. STATUS STEP BACK CROPPING

INPUT # SAVE PRESET OPTIMIZE
LOAD PRESET UNDER/OVER
— INPUT STATUS
ERASE PRESET ASPECT IN
— AUTOSET
PREDIFINE CROP
— FREEZE
ASPECT OUT
—  ACTIVE PLUG

— INPUT SETTINGS
COLORIMETRY

— TYPE
COMPONENT LEVEL
— AUTOSET
LOW LATENCY
— ENABLE

2:2 PULLDOWN

— SYNCHRONIZED
3:2 PULLDOWN

— VCR MODE

T,

RESET SETTINGS
— HDCP ENABLE

— H. SYNC LOAD

— 3D COMBO FILTER

— FORMAT

— AUDIO INPUT

— EDID

— STATUS
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8.4 Menu tree

MENU

vl

—

SCREEN SETTINGS

TYPE SCREEN # LAYER COPY MODE
LUMA KEY LAYER ADJUST
— BACKGRND COLOR
CHROMA KEY LAYER ZOOM

— QUICK FRAME

TITLING ALPHA SIZE TEMPLATES
—  AUTO TAKE

INVERT KEYING TRANSPARENCY
— PRESET TOOGLE

BORDER

FRC TRNSITION

OPENING EFFECT

CLOSING EFFECT

SMOOTH MOVE

“
jggL"YER COPY MODE
g LAYERZO0M
— EGEEY |
W PORDER
g OPENING EFFECT.
g S"IOOTH MOVE |
, ST

STATUS




8.3 Menu tree

MENU

[...]

LOGOS FRAME

ORIGIN FOR REC. AUDIO MODE VERSIONS

RECORD FRAMES SOURCE SETTINGS CONNECTION

1l
1

RECORD LOGOS |— # INPUT — RS232/LAN

RECORD ANIM — MUTE — RS232 BAURATE

— STEREO — LAN SETUP

1l

— ANALOG GAIN FUNCTIONS

— LEVEL BALANCE — AUTOLOCK

DIGITAL OUTPUT —AUTO QUICKFRAME

OUTPUT —  DYNAMICFIT

 PRESET MODE L PREVIEW ID
BREAKAWAY | HIDE UNUSED

TOP LAYER FOLLOW —  FREEZE MODE
| MASTER MUTE | STAND BY
| STEREO L DATE/TIME
| ANALOG LEVEL
| MASTER VOLUME
| BALANCE | KEY LOCKING
| SOURCE | MATRIX TK MODE
—  DELAY MODE | LCD BRIGHTNESS
| AUDIO DELAY | KEY BRIGHTNESS
__ 1KHZ OSC

[...]
SOURCE
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9.1 Dashboard (RCS?)

9. MAINTENANCE AND SUPPORT
9.1 Dashboard (RCS?)

On the RCS?, you have access to a chart with general information on the unit.
Please click on the Dashboard button:

DashBoard x  On this chart, you will find under the INFO tab, the
INFO Device name, the Serial number of your product, the
Dadce et AT actual firmware and the software version of the RCS?.

Sealumbac EH160 RCS: v01.00.20 Under CONNECTIVITY, you will find the current IP

address of your unit and its MAC address.

CONNECTIVITY

IP Addres 92.168.1.144 MAC Address




10.1 HDCP

10. APPLICATIONS NOTE AND TIPS
10.1 HDCP

HDCP is a content protection mechanism which uses encryption to prevent high value content from being
delivered to non-authorized devices. For example, Blu-ray players use HDCP on their HDMI outputs to ensure
that the HDMI output cannot be routed to a digital recording device.

The SmartMatriX? is fully HDCP compliant, meaning that you will be able to use the SmartMatriX? to accept
HDCP protected sources and route them to any HDCP protected outputs. As Analog Way is a licensed HDCP
adoptor, this also means that the SmartMatriX? is prevented from displaying any HDCP protected images on
any non-HDCP compliant outputs (as is the case for all licensed HDCP compliant devices).

HDCP can only be used on certain connection formats, including DVI, HDMI, and DisplayPort. Keep in mind
that simply because a connection is using a DVI, HDMI, or DisplayPort connection, it does not guarantee
that the devices connected are maintaining an active HDCP connection. For example, you may find video
recording or capture devices equipped with an HDMI input, however HDCP licensing forbids these devices
from capturing HDCP protected content.

HDCP is not supported on connection formats such as composite, component, Svideo, SD-SDI, HD-SDI,
3G-SDI, or VGA. This means that any source which becomes protected by HDCP cannot be converted to
these formats. For example, while you may find a Blu-ray player which can directly output a composite video
signal, HDCP licensing forbids converting the HDCP protected HDMI signal back to composite or any other
non-protected format.

To help troubleshoot HDCP in your installation, each input and output page is equipped with HDCP status
information to indicate in realtime when HDCP encryption is being used.

Certain devices such as Macintosh computers can be misleading to use in conjunction with an HDCP compliant
presentation switcher such as the SmartMatriX2. This is because devices like the Mac computers can be used
to output both HDCP protected content (such as a movie downloaded from iTunes) as well as non-HDCP
protected content (such as a Keynote presentation or the desktop). When a computer first connects to an
HDCP compliant device such as the SmartMatriX?, it learns the capabilities of the device through the EDID
connection. Upon seeing the HDCP compatibility of the attached SmartMatriX? devices like the Mac computers
will immediately attempt to use HDCP encryption at all times, despite the content currently displayed on the
computer screen. Since this source would now be considered an HDCP protected source, the SmartMatriX?
would be required to prevent it from being displayed on VGA or SDI outputs and only allow it to be displayed
on outputs protected by HDCP. To work around this problem, the SmartMatriX? allows the HDCP features of
a particular input to be disabled, which in turn informs the Mac computer to avoid using HDCP, and allows
content such as Keynote and the desktop to be displayed, as this input will no longer use HDCP protection.
Please note that disabling the HDCP features of the input do not circumvent HDCP protections, and thus do
not allow you to view any content which requires this protection.

For more information about HDCP, please refer to our whitepapers on HDCP, or visit the HDCP foundation
website.




10.2 HDBaseT™

10.2 HDBaseT™

HDBaseT is a global standard of the transmission of high-definition video and audio, Ethernet, controls, USB
and up to 100W of power over a single cable, for up to 100M/328ft.

The SmartMatriX?-H (Ref. SMX250-H) is fully compliant with the HDBaseT Specifications.

Equipped with HDBaseT receivers and transmitters, the SmartMatriX?-H is able to input video, embedded
audio, Ethernet pass-through and manage a Power over Ethernet feed (30W) and to output video, embedded
audio, Ethernet, plus a bidirectional Serial connection and a IR connection.

The bidirectional serial and the IR connection are output via the 5-pin MCO connectors associated to the
HDBaseT port.

Based on the HDBaseT specifications of the HDBaseT Alliance, the SmartMatriX?-H is compatible with the
list of HDBaseT products referenced by the HDBaseT alliance. The full list of available products are listed at
https://hdbaset.org/advanced-search/

In case of issue with your installation, the HDBaseT alliance has released a troubleshoot guide.
The document is available at http://installers.hdbaset.org/wp-content/uploads/2014/06/Installers-10-
commandments.pdf and the content of the document is :

1. LAN is the Cable

HDBaseT runs on a regular cable (Cat5E or above), so any best practices regarding Ethernet installations also
apply here. Cable performance is defined by the quality of the cable, the distance of the connection, the
handling of the cable and the video resolution expected. A rule of thumb is that the higher resolution, the
better the cable should be. The same goes for distance.

The cabling infrastructure in any project is likely to be around for a long time -it should last longer than
any other component in the network, and choice of cable should take into consideration new applications,
additional users and potential expansions of the whole systems.

2. Thou shalt not untwist your wires unnecessarily

There is a reason that the wires are twisted: it cancels out electromagnetic interference (EMI) from external
sources and crosstalk from neighboring conductors. When terminating the cable, make sure not to untwist
more than half-an-inch (and preferable a quarter-of-an-inch) form the point of termination, and remove as
little of the sheath as possible.

3. Thou shalt handle your cable with care

LAN cable are fairly resilient. Yet, any rough handling, such as tight tie wraps, clamping or stapling can
damage the cable, compromising performance or event preventing signal transmission. Tie cables loosely
with appropriate cable wraps, and make sure to use appropriate cable support systems when too many
cables are involved, such as trays, carriers or J-hooks. If pulling cables is necessary, make sure not to pull
too hard because that also may cause pairs to untwist and degrade performance. Cable physical protection
safeguards the integrity of data transmission.

4. Thou shalt not overbend your cables

Another important issue for cable integrity is the bend radius. Bend radius is the inside curve of the cable
during and agter installation. It is best to keep the minimum bend radius at least at four times the diameter
of the cable — that means that the cable should not be bent below that radius, so as not to damage it and
compromise signal transmission. Overbending may lossent or otherwise modify the wire twisting and increase
susceptibility to external noise and near-end crosstalk within the cable.
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10.2 HDBaseT™

5. Thou shalt keep your cables away from power sources

Cables should be kept at a distance of at least 12 inches from power cables. In an environment prone to high
EMI, it is best to use shielded cables. Most Cat5e cables are unshielded, which makes them more flexible,
durable and inexpensive. But they are also more susceptible to EMI. If using unshielded cables, keep them
away from any source of EMI such as other cables, transformers and light fixtures. In high RF environments,
it is best to use shielded cables.

The same applies to shielded connectors. In a shielded connector, the signal pins are surrounded by a metal
shield and further reduce electromagnetic interference. Shielded connectors provide a better fit and therefore
better performance.

6. Thou shalt mind your distances carefully

HDBaseT delivers the 5Play feature set over 100m/328ft. One of the factors that affects distance is the quality
of the cable used, the working environment, and the video resolution expected. Higher quality cable will
keep the signal better than low quality cable over distances. A noise-free environment will deliver better
performance over the distance than a noisy or EMI-prone environment. Some HDBaseT equipment allows for
Long Reach connectivity -150m/492ft- for lower resolutions of 720p.

7. Thou shalt not use patch cords unnecessarily

If possible, avoid patch cords or cables altogether, as every connection introduces losses in the transmission.
If absolutely necessary, make sure to use less than two per cable run and keep each less than five meters
from the end.

8. Thou shalt terminate carefully

One of the advantages of HDBaseT’s using of LAN cables os that they are easily field terminated. That means
there is no need to pre-measure cables and bring all the set-up ready ahead of time, saving time & money.
Make sure to use proper equipment for termination, such as cable strippers, electrician scissors, and crimpers.
Alos, make sure that both ends of the cable are wired according to the same scheme, either T568A or T568B.
Never use both in the same installation. It is also recommended to check with HDBaseT manufacturers which
scheme their products are optimized and equalized for, to take full advantage of the expected performance.

9. Thou shalt be thorough and test, test, test

Testing is crucial to guarantee both cable quality and signal integrity. Pre-testing ca save hours and resources
from troubleshooting any issue ahead of time. During and after installation, a professional test equipment
will check connections and transmission of the installed infrastructure, beyond broken or mismatched wires,
but also any hidden issues that may cause interference or loss of signal. Make sure to test every cable as it is
installed and terminated, to identify individual problems as the installation goes.

10. Thou shalt be organized

Document and label all cabling components to facilitate any upgrades or expansions later, including
diagrams. Remove any abandoned cables to prevent accidents or fire hazards. Avoid routing cables through
pipes and holes, which may limit additional future cable runs.




11.1 Warranty conditions

—(O 11. WARRANTY
11.1 Warranty conditions

Analog Way warrants the product against any defects in materials and workmanship for a period of three
(3) years from the date of purchase when used in accordance with the user’s manual and standard industry
practices.
¢ In the unlikely event of any malfunction from such defects during the warranty period, Analog Way will, at
its discretion, repair or replace the defective units.
¢ The warranty does not apply if the product is determined to have been:
- Improperly installed or abused,
- Handled with improper care,
- Used or stocked in abnormal conditions,
- Modified, opened,
- Damaged by fire, war, or Natural disasters (Acts of God)
¢ Analog Way’s direct employees are solely authorized to make this determination.
¢ Analog Way reserves the right to refuse for repair and service a product for which the warranty is void.
¢ In no way shall Analog Way be responsible for direct or indirect loss of profit or consequential damages
resulting from any defect in this product.

NOTE: Analog way offers a warranty extension of 2 years, it includes parts, labor and return shipping. If you
are interested, please contact your territory sales representative.

11.2 Repair and return instructions

These Return Material Authorization (RMA) regulations determine the procedure to be followed when
returning defective product. The aim is to ensure fast and simple handling of the returned product and bring
the best satisfaction

In the unlikely event that a product is required to return for repair, please call the regional Maintenance

center/Customer Service, and ask to receive a Return Material Authorization number (RMA). Three regional

maintenance centers are available depending on your location. (See chapter: 12. Contact information)

e Before sending any device to Analog Way, please contact us to obtain a Return Material Authorization
(RMA) number. Please have the model and serial number available and the reason for calling.

e RMAs are valid for 30 days, after which a new RMA must be requested.

e Package the unit securely in the original shipping materials or suitable equivalent. Analog Way is not
responsible for damage which occurs due to improper packaging. The customer assumes responsibility
until the unit arrives at our facility.

e Out-of-warranty products will be charged an evaluation fee if no problems are found or if you choose not
to proceed with the repair.

e Discontinued products are not admitted for return and repair.

e Be sure to include the RMA number clearly on the shipping label or on the exterior of the package.

e No unit will be accepted without a valid RMA clearly visible.

11.3 Return conditions

In the unlikely event that you want to return the product, please call the regional Maintenance center/

Customer Service

e If you are unhappy with the performance of any product purchased from us, you can return it within 30
days of purchase.

¢ Returned equipment must be in original condition with all accessories and packaging materials.

e Returns may be subject to a refurbishment and/or restocking fee.
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12. Contact information

—O 12. CONTACT INFORMATION

[ The Americas
Il Europe, Middle East & Africa
I Asia Pacific

Analog Way SAS - Headquarters
Tel.: +33 (0)1 81 89 08 60

2/4 rue Georges Besse
92160 Antony
FRANCE

Sales/General information:
saleseuro@analogway.com

Technical support:
techsupport@analogway.com
Tel.: +33 (0)1 81 8908 76

Analog Way Germany

Tel.: +49 (0)160 90 624 624
Tel.: +49 (0)160 97 539 542
salesgermany@analogway.com

GERMANY O

Analog Way Inc.

Tel.: +1 (678) 487 6644
Toll free: +1 855 353 4988
3047 Summer Oak Place
Buford, GA 30518

USA

Sales/General information:
salesusa@analogway.com

Technical support:
techsupport@analogwayusa.com

Analog Way Italy
Tel.: +39 02 39493943
salesitaly@analogway.com

Analog Way Pte Ltd
Tel.: +65 6292 5800

152 Beach Road
#15-03 Gateway East
SINGAPORE 189721

Sales/General information:
sales@analogwayasia.com

Technical support:
techsupport@analogwayasia.com

Analog Way UK

Tel.: +44 (0) 7774 143472
Tel.: +44 (0) 7946 303271
salesuk@analogway.com




13.1 Crestron 3 series

—O 13. APPENDICES

13.1 Crestron 3 series Midra™ Driver

Using this driver, software developers and integrators can easily provide
@CRESTRON powerful solutions for remotely controlling any Midra™ series Switchers
through Crestron 3-series Control Systems®.
The package includes:
- The precompiled driver modules that can be used for recalling presets, selecting source inputs, changing PIP
content, configuring audio inputs and outputs...,
- One sample SIMPL program that demonstrates the use of all the features available within this driver,
- Two VTPro sample projects, one for XPanel and one for the Crestron Mobile Pro® application (for iPad® and
Android™ devices), both running with the sample program mentioned above,
- Help files in French and English.

The samples provided are ready-to-use programs and can be freely adapted or used as a base to build your
own real-world Midra™ controller application.

13.2 AMX NetLinx® Integrated Controllers Midra™ Driver

Using this driver, software developers and integrators can easily provide powerful solutions for remotely

A w controlling any Midra™ series Switchers through AMX NetLinx® integrated
controllers.
all .A The package includes:

- The precompiled driver modules that can be used for recalling presets, selecting source inputs, changing PIP
content, configuring audio inputs and outputs...,

- One sample NetLinx® Studio program that demonstrates the use of all the features available within the
driver,

- Two TPDesign4 sample projects, one for AMX Modero® S Touch Panels and one for Apple® iPad, both
running with the sample program mentioned above,

- Help files in French and English.

The samples provided are ready-to-use programs and can be freely adapted or used as a base to build your
own real-world Midra™ controller application.
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